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About This Guide

This guide describes how to install and configure the Novell® ClientTM for Windows 2000/XP 
version 4.91 and later software.

IMPORTANT: The Novell Client is not supported on Windows XP Home Edition.

If you are using a previous version of the Novell Client software, you should update it to the latest 
version from the Novell Download Web site (http://download.novell.com). If you are using a 
previous version of the Novell Client software, some of the information in this documentation might 
not apply.

This guide is divided into the following sections:

Chapter 1, “What's New,” on page 11
Chapter 2, “Preparing to Install the Novell Client,” on page 13
Chapter 3, “Installing the Novell Client on a Single Workstation,” on page 17
Chapter 4, “Installing and Upgrading the Novell Client on Multiple Workstations,” on page 21
Chapter 5, “Setting Client Properties,” on page 53
Chapter 6, “Managing File Security and Passwords,” on page 57
Chapter 7, “Managing Login,” on page 71
Chapter 8, “Printing to a Network Printer,” on page 91
Chapter 9, “Uninstalling the Novell Client,” on page 95
Appendix A, “Troubleshooting Issues,” on page 99
Appendix B, “Documentation Updates,” on page 103

For information on accessing data on a Linux* server using the same methods you use on a 
NetWare® server using the Novell Client for Windows software, see the NCP Server for Linux 
Administration Guide (http://www.novell.com/documentation/oes/ncp_lx/data/
h9izvdye.html#h9izvdye).

Audience

This guide is intended for network administrators. 

Feedback

We want to hear your comments and suggestions about this manual and the other documentation 
included with this product. Please use the User Comments feature at the bottom of each page of the 
online documentation, or go to www.novell.com/documentation/feedback.html and enter your 
comments there.

Documentation Updates

For the latest version of this documentation, see the Novell Clients online documentation (http://
www.novell.com/documentation/lg/noclienu/index.html).
About This Guide 9

http://www.novell.com/documentation/oes/ncp_lx/data/h9izvdye.html#h9izvdye
http://www.novell.com/documentation/oes/ncp_lx/data/h9izvdye.html#h9izvdye
http://download.novell.com
http://www.novell.com/documentation/oes/ncp_lx/data/h9izvdye.html#h9izvdye
http://www.novell.com/documentation/oes/ncp_lx/data/h9izvdye.html#h9izvdye
http://www.novell.com/documentation/lg/noclienu/index.html
http://www.novell.com/documentation/oes/ncp_lx/data/h9izvdye.html#h9izvdye
http://www.novell.com/documentation/oes/ncp_lx/data/h9izvdye.html#h9izvdye


10 Novell

novdocx (en)  16 A
pril 2010
Additional Documentation

For documentation on known issues, see the Novell Client 4.91 for Windows 2000/XP/2003 
Readme (http://www.novell.com/documentation/noclienu/index.html).

For documentation on login scripts, see the Novell Login Scripts Guide (http://www.novell.com/
documentation/linux_client/login/data/front.html).

Documentation Conventions

In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
within a cross-reference path.

A trademark symbol (®, TM, etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party 
trademark.
 Client 4.91 SP5 for Windows XP/2003 Installation and Administration Guide
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1What's New

Section 1.1, “Novell Client 4.91 Support Pack 5 for Windows XP/2003,” on page 11
Section 1.2, “Novell Client 4.91 Support Pack 4 for Windows XP/2003,” on page 11
Section 1.3, “Novell Client 4.91 Support Pack 3 for Windows XP/2003,” on page 11
Section 1.4, “Novell Client 4.91 Support Pack 2 for Windows XP/2003,” on page 11
Section 1.5, “Novell Client 4.91 Support Pack 1 for Windows XP/2003,” on page 12
Section 1.6, “Novell Client 4.91 for Windows XP/2003,” on page 12

1.1  Novell Client 4.91 Support Pack 5 for 
Windows XP/2003
Several bugs have also been resolved since the last release. See “Section 6.0 Fixes Since the Last 
Release” in the Novell Client 4.91 SP5 for Windows XP/2003 Readme (http://www.novell.com/
documentation/noclienu/clientreadme/data/ncw_readme_sp5.html) for more information. 

1.2  Novell Client 4.91 Support Pack 4 for 
Windows XP/2003
The Novell® ClientTM 4.91 SP 4 for Windows XP/2003 includes the ability to configure 802.1x 
authentication. For more information, see Section 7.5, “Configuring 802.1X Authentication,” on 
page 77

Several bugs have also been resolved since the last release. See “Section 6.0 Fixes Since the Last 
Release” in the Novell Client 4.91 SP4 for Windows XP/2003 Readme (http://www.novell.com/
documentation/noclienu/clientreadme/data/ncw_readme_sp4.html) for more information. 

1.3  Novell Client 4.91 Support Pack 3 for 
Windows XP/2003
This release contains bug fixes only. For a list of fixes, see “6.0 Fixes Since the Last Release” in the 
Novell Client 4.91 SP3 for Windows 2000/XP/2003 Readme (http://www.novell.com/
documentation/noclienu/clientreadme/data/ncw_readme_sp3.html).

1.4  Novell Client 4.91 Support Pack 2 for 
Windows XP/2003
This release includes additional Forgotten Password Recovery functionality. When a user logs in, 
the Novell Client checks to see if the password policy uses Challenge Response and if the user has 
entered responses. If responses have not been entered, the user is notified and a dialog box opens so 
that her or she can enter the responses. Additionally, if the password policy uses a password hint or a 
password reminder and this has not been set, the Novell Client prompts the user to enter this 
information.
What's New 11
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1.5  Novell Client 4.91 Support Pack 1 for 
Windows XP/2003
This release includes a new feature that lets users recover when they forget their password. On the 
client login dialog box is a “Forget your password?” link. For more information, see Section 6.3.1, 
“Using the “Did You Forget Your Password?” Link,” on page 62.

1.6  Novell Client 4.91 for Windows XP/2003
This release includes the following new features:

Changes to the Update Agent to allow you to deploy new property page settings. For more 
information, see Section 5.3, “Setting Properties on Multiple Workstations after Installation,” 
on page 54.
Changes to Automatic Client Upgrade that allow you to enable the Update Agent on multiple 
workstations without running a complete software installation. For more information, see 
“Enabling the Novell Client Update Agent by Using ACU Without Installing Novell Client 
Software” on page 41.
Changes to the Novell Client Update Agent and Automatic Client Upgrade to allow 
components to be uninstalled. For more information, see Section 9.2, “Uninstalling Network 
Components Using Update Agent or ACU,” on page 95. 
Unicode* filenaming in mixed language environments.
Implementation of the Novell Universal Password (also know as the NDS® Login Method), 
available in NetWare 6.5 and later, which provides more robust and strong password and 
password management so users can create a common password that can be used by all 
protocols for authentication. Also included are support for password hints, administrator 
messages, and password requirements. For more information, see Section 6.2, “Managing 
Passwords,” on page 58. For more information on disabling NMAS and NICI, see Section 2.6, 
“Configuring Security Authentication,” on page 14. 
Support for the NetIdentity agent
The NetIdentity agent can be installed with the Novell Client or as a separate installation. It 
provides background authentication to Windows Web-based applications that require Novell 
eDirectoryTM authentication, such as iPrint, Novell Virtual Office, and NetStorage.
Windows NT* is no longer supported.
 Client 4.91 SP5 for Windows XP/2003 Installation and Administration Guide
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2Preparing to Install the Novell 
Client

This section explains how to prepare to install the Novell® ClientTM for Windows 2000/XP software.

Section 2.1, “Novell Client Software Version Numbers,” on page 13
Section 2.2, “Supported Windows Platforms,” on page 13
Section 2.3, “Supported Server Platforms,” on page 14
Section 2.4, “Locating the Latest Client Software,” on page 14
Section 2.5, “Checking for Client Workstation Incompatibilities,” on page 14
Section 2.6, “Configuring Security Authentication,” on page 14
Section 2.7, “Additional Information,” on page 15

2.1  Novell Client Software Version Numbers
The following software is included in the Novell Client 4.91 SP5 for Windows XP/2003 build:

Novell Client 4.91 SP5 for Windows XP/2003
NMASTM 3.4
NMAS Challenge Response Method 2.07.0001
NICI 2.7.3
NetIdentity Agent 1.2.3

2.2  Supported Windows Platforms
The Novell Client for Windows supports the following Windows operating systems. For all 
platforms, the Novell Client supports only 32-bit versions of Windows. The Novell Client cannot be 
installed on a 64-bit version of Windows 2003, Windows XP, or Windows 2000. 

Windows 2000 Professional
Windows 2000 Server
Windows 2000 Advanced Server
Windows Server 2003 Server Edition
Windows Server 2003 Enterprise Edition
Windows XP Professional
Windows XP Tablet PC Edition

IMPORTANT: The Novell Client might run but is not supported on Windows XP Home edition.
Preparing to Install the Novell Client 13
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2.3  Supported Server Platforms
The Novell Client 4.91 SP5 for Windows XP/2003 supports Novell Open Enterprise Server (OES) 
1, OES 2, NetWare® 5.1, NetWare 6.0, and NetWare 6.5.

2.4  Locating the Latest Client Software
Novell Client software is available from the Novell Download (http://download.novell.com) Web 
site and as a part of the Consolidated Support Pack CD.

2.4.1  Downloading the Latest Software
1 Create an installation directory.
2 At the Novell Downloads (http://download.novell.com) Web site, select Novell Client from the 

Product or Technology drop-down list.
3 Click Search.
4 Click the Client software that you want to download.
5 Follow the download instructions provided with the files on the Web site.

2.4.2  Locating the Latest Software on the Consolidated 
Support Pack CD
To locate the latest Novell Client software on the Consolidated Support Pack CD, check the Readme 
file located at the root of the CD. This file indicates the location of all software on the CD and gives 
instructions for installation. 

2.5  Checking for Client Workstation 
Incompatibilities
The Novell Client is not designed to run on Windows XP Home Edition.

2.6  Configuring Security Authentication
By default, Novell Client implements the Novell Universal Password, which provides robust and 
strong passwords. As a part of this implementation, Novell Client installs NMAS and NICI. 

NMAS authentication adds additional security to the network. However, if your network does not 
use NMAS, login might take additional time and you might want to disable NMAS authentication 
on the server and not install it with the Novell Client software. Novell Client installs NICI Client 
2.6.8.2 and NMAS Client 3.2.0.6 by default. If you do not want to install them during the Client 
installation, install using a configuration file (unattend file) that specifies not to install them. For 
more information, see “Creating the Configuration File (Unattend File)” on page 47. 

NOTE: If you disable NMAS, the Challenge Response functionality is not available.

For more information on disabling NMAS, see “Disabling NMAS on the Server” in the Novell 
Modular Authentication Services 3.0 Administration Guide (http://www.novell.com/documentation/
nmas30/index.html?page=/documentation/nmas30/admin/data/am4bbpx.html).
 Client 4.91 SP5 for Windows XP/2003 Installation and Administration Guide
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For more information on deploying universal passwords, see the Universal Password Deployment 
Guide in the Novell Modular Authentication Services 3.0 Administration Guide (http://
www.novell.com/documentation/nmas30/index.html?page=/documentation/nmas30/admin/data/
allq21t.html).

2.7  Additional Information
“Installing the Novell Client on a Single Workstation” on page 17
“Installing and Upgrading the Novell Client on Multiple Workstations” on page 21
Preparing to Install the Novell Client 15

http://www.novell.com/documentation/nmas30/index.html?page=/documentation/nmas30/admin/data/allq21t.html
http://www.novell.com/documentation/nmas30/index.html?page=/documentation/nmas30/admin/data/allq21t.html
http://www.novell.com/documentation/nmas30/index.html?page=/documentation/nmas30/admin/data/allq21t.html
http://www.novell.com/documentation/nmas30/index.html?page=/documentation/nmas30/admin/data/allq21t.html
http://www.novell.com/documentation/nmas30/index.html?page=/documentation/nmas30/admin/data/allq21t.html


16 Novell

novdocx (en)  16 A
pril 2010
 Client 4.91 SP5 for Windows XP/2003 Installation and Administration Guide



3
novdocx (en)  16 A

pril 2010
3Installing the Novell Client on a 
Single Workstation

This section explains how to install the Novell® ClientTM for Windows software on one workstation. 

If you plan to install the Novell Client software on a small number of workstations, or if the 
workstations are not yet connected to a network, download the software from the Novell Download 
(http://download.novell.com) Web site. 

If you are installing or upgrading the Novell Client software on several workstations on the network, 
consider using the network installation explained in “Installing and Upgrading the Novell Client on 
Multiple Workstations” on page 21.

Section 3.1, “Installing Novell Client Software on a Workstation,” on page 17
Section 3.2, “Using Setup Parameters with the Novell Client Installation,” on page 18
Section 3.3, “Configuring Network Protocols,” on page 18
Section 3.4, “Common Networking Tasks,” on page 19

3.1  Installing Novell Client Software on a 
Workstation

1 Do one of the following: 
Download the latest Novell Client software and then follow the download instructions 
included on the download page.
Install the Novell Client software from the Consolidated Support Pack CD. 

See Section 2.4, “Locating the Latest Client Software,” on page 14.

TIP: There are several customized parameters that you can use during the installation by 
running the installation from the command line. These include special accessibility settings, 
status logging, automatic client upgrade, and others. For more information, see Section 3.2, 
“Using Setup Parameters with the Novell Client Installation,” on page 18.

2 Make sure that the logged-in user is an administrator on the workstation because users without 
administrator rights to the workstation cannot install new software.

3 Double-click setupnw.exe in directory where you unzipped the download file.
4 Follow the on-screen instructions. 

The typical installation installs the basic Novell Client and upgrades any components you 
currently have on the workstation that are also included in this version. Components that are 
not upgraded in this version of the Novell Client are not changed. 

TIP: The Typical Install option installs only the basic Novell Client components. If you want 
to install NDPS®, use the Custom Installation option. If you are upgrading Novell Client 
software, the same custom components are installed unless you choose different ones. If 
Installing the Novell Client on a Single Workstation 17
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components that were previously included with the Novell Client installation (such as 
ZENworks®) are no longer included with the installation, these components are left alone and 
are not upgraded or deleted. 

The Custom installation allows you to choose which components are installed. 

NOTE: NICI Client 2.7 and NMASTM Client 3.0 are installed by default. If they are already 
installed, they are updated automatically. You can control both the installation and use of 
NMAS by installing the Novell Client using a configuration (unattend) file. For more 
information, see “Creating the Configuration File (Unattend File)” on page 47.

5 When the installation is complete, reboot your workstation. 

3.2  Using Setup Parameters with the Novell 
Client Installation
There are several customized parameters that you can use during the installation by running the 
installation from the command line. These include special accessibility settings, status logging, 
automatic client upgrade, and others.

1 Click Start > Run.
2 Type the path to the software followed by a space, a slash (/), and then the parameter.

path_to_the_software\setupnw.exe [/u] [/u:path_to_an_unattend_file] [/sl] 
[/sl:path_to_status_log_file] [/acu] [/508] [/?]

The following table explains the setup parameters.

Table 3-1   Windows 2000/XP Setup Parameters

3.3  Configuring Network Protocols
After you install the Novell Client, make sure that it is configured correctly for your network.

Parameter Description

U Use settings in the default configuration (unattend) file, unattend.txt. 

U:path Use settings in the specified configuration (unattend) file, specified in the path given.

SL Create status log entries in the default status file, status.log.

SL:path Create status log entries in the specified status log file, specified in the path given.

ACU Automatically upgrade the client if it is an older version. 

508 Enable special accessibility options in accordance with the Workforce Investment Act 
of 1998 Section 508. 

? Display help screen for setup parameters.
 Client 4.91 SP5 for Windows XP/2003 Installation and Administration Guide
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IMPORTANT: Before you configure network protocols, make sure you have the correct 
information and any addresses needed. If you configure protocols incorrectly, the workstation 
cannot connect to the network, or it might conflict with other workstations using the same address. 

1 Right-click My Network Places, click Properties, right-click Local Area Connection, select the 
protocol that you want to configure, then click Properties.

2 Configure the protocol options on each tabbed page, then click OK.
For example, if your network uses DHCP to assign IP addresses automatically, click the IP 
Address tab and then click Obtain IP Address Dynamically. Or, if you must use a static IP 
address, click Specify an Address and type a valid IP address.

TIP: Click the question mark in the upper right corner, then click in any field for more 
information about that field.

3 Click OK.
You might be prompted to supply the Windows operating system CD. If you do not have access 
to the correct files, you might not be able to create a network connection.

You should now set the Novell Client properties for the workstation. See Chapter 5, “Setting Client 
Properties,” on page 53.

3.4  Common Networking Tasks
Novell Client software is integrated with Windows. Features are integrated into standard Windows 
interfaces such as My Computer, Network Neighborhood, Control Panel, and the Red N icon 
(Description: Novell Services icon ) on the status bar.

Instructions for performing common client tasks are provided under the Red N menu:

1 Right-click the Red N icon in the notification area.
2 Click Novell Client Help > Novell Client User Guide.
Installing the Novell Client on a Single Workstation 19
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4Installing and Upgrading the 
Novell Client on Multiple 
Workstations

This section explains how to install and upgrade the Novell® ClientTM for Windows software on 
multiple workstations either across a network or from a Web server. It also discusses how to set up 
full-client installations, updates, and Support Pack installations. 

Because the Novell Client software installation options are robust and flexible so that they can be 
customized to suit your needs, a general understanding of all the options and processes is provided 
first. Subsequent sections help you decide which installation processes are best for your situation. 
Then, the specific installation steps are given. Finally, ways to control what users see during 
installation are discussed.

Section 4.1, “Understanding Novell Client Installation and Update Options,” on page 21
Section 4.2, “Understanding Which Installation Process to Use,” on page 29
Section 4.3, “Novell Client Installation Procedures,” on page 34

4.1  Understanding Novell Client Installation and 
Update Options
Novell Client software has a robust set of tools that enable you to deploy client software upgrades 
and Support Packs to all workstations in your network without installing individually on each 
workstation. These tools can be combined in several different ways to create custom installation 
methods that suit your network and your workstation configurations. 

The Novell Client can also be installed or updated from either a network server using a UNC path or 
mapped drive, or it can be installed or updated from a Web server using a URL. Depending on your 
network and the workstations that need to be updated, you might want to configure one or both of 
these installation methods. Using both of these methods is explained later in this section. 

TIP: For more information about installing on one workstation, see Chapter 3, “Installing the 
Novell Client on a Single Workstation,” on page 17.

A general understanding of all of the tools and how they work together can help you decide which 
tools are best suited for your needs. The following is an explanation of the various tools and 
configuration files that can be used to customize the installation or update of the Novell Client 
software. 

Section 4.1.1, “Understanding the Basic Novell Client Installation (setupnw.exe),” on page 22
Section 4.1.2, “Understanding Novell Client Support Pack Installation (setupsp.exe),” on 
page 22
Section 4.1.3, “Understanding Automatic Client Upgrade (acu.exe),” on page 23
Section 4.1.4, “Understanding Novell Client Install Manager (nciman.exe),” on page 25
Installing and Upgrading the Novell Client on Multiple Workstations 21
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Section 4.1.5, “Understanding Novell Client Web Install Utility (setupip.exe),” on page 25
Section 4.1.6, “Understanding the Novell Client Update Agent (cuagent.exe),” on page 27

4.1.1  Understanding the Basic Novell Client Installation 
(setupnw.exe)
Novell Client software is installed by setupnw.exe. 

Figure 4-1   Basic Novell Client Installation

The setupnw.exe installation process can be modified by two different command line switches:

/U: Applies client settings and modifies install behavior based on settings in a specified 
configuration (unattend) file created by Novell Client Install Manager (nciman.exe). For more 
information, see “Creating the Configuration File (Unattend File)” on page 47.
/ACU: Directs setupnw.exe to perform an upgrade of the currently installed client software 
only if the version to be installed is a later one. 

/ACU and /U can be specified together at the command line.

4.1.2  Understanding Novell Client Support Pack Installation 
(setupsp.exe)
If workstations need to have only a specific Support Pack applied, use the Novell Client Support 
Pack installation utility (setupsp.exe). The Support Pack installs only a subset of client files and 
does not require a client version change. Support Pack Install Files can also be added to the Client 
Install Files (in an overlay manner) to allow the installation of both the client and the Support Pack 
in one step. For more information, see “Installing Support Packs” on page 42.

setupnw.exe

/acu
/u

unattend
file
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Figure 4-2   Support Pack Installation

Setupsp.exe can be customized by modifying the setupsp.inf file to specify Support Pack 
options, display options, and update options. 

4.1.3  Understanding Automatic Client Upgrade (acu.exe)
The Automatic Client Upgrade utility (acu.exe) determines whether the client needs to be updated, 
allows you to specify several installation options, and allows you to uninstall unwanted components. 
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Figure 4-3   Automatic Client Upgrade Process

ACU's actions are determined by acu.ini, a text file that can be modified to change the behavior of 
acu.exe. ACU can also accept information from a configuration (unattend) file that is created by 
Novell Client Install Manager (nciman.exe). For more information, see “Creating the 
Configuration File (Unattend File)” on page 47.

IMPORTANT: If you use a configuration (unattend) file to configure Novell Client with acu.exe, 
you must change the Use=No to Use=Yes and you must specify the name of the configuration file 
and the path to it in the File=\\server\volume\path\file. Both of these changes are made in the 
[UNATTENDFILE] section of the acu.ini file.

ACU can be launched from within the login script. ACU determines if a complete update of the 
Novell Client (setupnw.exe) or a Support Pack (setupsp.exe) is required and then launches the 
appropriate utility. Each utility then can use the associated configuration files to complete a 
customized installation. Launching ACU from the login script saves network bandwidth during 
login because the Setup utility is run only if the client needs to be updated. 
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4.1.4  Understanding Novell Client Install Manager (nciman.exe)
Novell Client Install Manager (nciman.exe) generates a configuration (unattend) file that sets client 
settings and dictates client installation behavior. Novell Client Install Manager is located in the 
admin folder in the directory where you unzipped the download file. This file can be used by the 
Automatic Client Upgrade utility (acu.exe) or by the Client install utility (setupnw.exe). You can 
create several different configuration files for different groups of workstations if necessary and 
specify their use by indicating a path to the desired configuration file in the acu.ini file or at the 
command line. For more information, see “Creating the Configuration File (Unattend File)” on 
page 47.

4.1.5  Understanding Novell Client Web Install Utility 
(setupip.exe)
The Novell Client Web Install utility simplifies the creation of a Web-based installation. 
Setupip.exe is a utility that downloads the Novell Client install files from a Web server and 
launches the Novell Client install. 
Installing and Upgrading the Novell Client on Multiple Workstations 25
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Figure 4-4   Novell Client Web Install Utility

Setupip.exe is created by running writeip.exe. It can configure up to five different addresses 
that the client can be installed from as well as indicate whether to launch a full client installation 
(setupnw.exe) or to launch a Support Pack installation (setupsp.exe). It can also be configured to 
accept settings from a configuration (unattend) file. 

Setupip.exe can also launch acu.exe to determine if a complete installation or a Support Pack 
installation needs to be launched. 
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Figure 4-5   Novell Client Web Install Affected by ACU

4.1.6  Understanding the Novell Client Update Agent 
(cuagent.exe)
The Novell Client Update Agent provides a workstation-initiated (manual or automatic) update of 
the Novell Client software. It launches acu.exe from a specified location. The Update Agent can be 
run manually from the Red N menu or it can be configured to automatically check for updates at 
specified intervals. 
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Figure 4-6   The Novell Client Installation Update Agent

If it is configured to check automatically, each time a user logs in to the network, it runs and 
determines if the preconfigured number of days have elapsed since the last upgrade check and then 
checks the specified location for a newer version of the client or for Support Pack updates. If a 
newer version or Support Pack is found, ACU then launches the appropriate installation process. 

NOTE: Before workstations can check to see if updates are available, the Update Agent must be 
configured during a software installation or by using Automatic Client Upgrade (ACU). Or, you can 
configure the Update Agent on each machine locally through the Novell Client property pages. 

The Update Agent is configured by modifying the Update Agent property page settings or 
(optionally) the cuagent.ini file. Because the Update Agent launches ACU, which in turn 
launches either setupnw.exe or setupsp.exe, all of the configuration changes made to these 
subsequent utilities are used in the same way they would be when not running the Update Agent. For 
more information, see “Setting Up the Novell Client Update Agent” on page 37.
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4.2  Understanding Which Installation Process to 
Use
Now that you have an understanding of the tools available, you should choose the best installation 
methods for your network. To simplify the decision of what processes to use, refer to the decision 
tree in Figure 4-7 or Figure 4-8. Each possible installation method is listed as a part of the tree. 

If you have a complex network, you might need to refer to the decision tree multiple times to decide 
which installation type is right for different segments of the network. For example, you might have 
workstations that connect to the network through a NetWare® server and workstations that access 
only a corporate Web server. You might have deployed the Novell Client previously with the Update 
Agent configured to some workstations and not to others. 

It is important to note that if your network has workstations that have different requirements, the 
steps that you ultimately take to deploy the Novell Client might be very similar or the same. The 
decision trees can help you to understand the specific steps needed in each case. 

The following decision trees explain options for a network installation of the Novell Client or 
Support Pack update (Figure 4-7 on page 29) or a Web installation of the Novell Client (Figure 4-8 
on page 30).

Figure 4-7   Network Installation or Service Pack Decision Tree
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Figure 4-8   Web Installation Decision Tree
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Update Agent Custom Install (Network Server Decision Tree Option 2)

The following is the procedure required to complete a custom installation of the Novell Client on 
workstations that already have Novell Client installed with the Update Agent configured and that 
have a connection to the network. 

TIP: Before you set up a custom install, consider which options you want users to see during 
installation. You can make the necessary modifications to the corresponding configuration files 
while making other custom install changes. 

1. Set up the Novell Client Install on a NetWare server. 
2. (Optional) Create a custom configuration (unattend) file. 
3. (Optional) Modify the installation options in the acu.ini file.
4. Set up Novell Client Upgrade Agent. 
5. (Optional) Modify the installation options in the cuagent.ini file.
6. Deploy the client installation by using the selected method. 

Default Network Upgrade Without the Update Agent (Network Server Decision Tree 
Option 3)

The following is the procedure required to complete the default update of the Novell Client on 
workstations that already have the Novell Client installed without the Update Agent configured, but 
with a connection to the network. 

1. Set up the Novell Client Install on a NetWare server. 
2. Deploy the client installation by using the selected method. 

Custom Network Upgrade Without the Update Agent (Network Server Decision Tree 
Option 4)

The following is the procedure required to complete the custom update of the Novell Client on 
workstations that already have the Novell Client installed without the Update Agent configured but 
with a connection to the network. 

TIP: Before you set up a custom install, consider which options you want users to see during 
installation. You can make the necessary modifications to the corresponding configuration files 
while making other custom install changes. 

1. Set up the Novell Client Install on a NetWare server. 
2. (Optional) Create a custom configuration (unattend) file. 
3. (Optional) Modify the installation options in the acu.ini file.
4. Deploy the client installation by using the selected method. 
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Default Network New Installation (Network Server Decision Tree Option 5)

The following is the procedure required to complete the default installation of the Novell Client on 
workstations that do not have the Novell Client installed but do have a connection to the network. 

1. Set up the Novell Client Install on a NetWare server. 
2. Deploy the client installation by using the selected method. 

Custom Network New Installation (Network Server Decision Tree Option 6)

The following is the procedure required to complete the custom installation of the Novell Client on 
workstations that do not have the Novell Client installed but do have a connection to the network. 

TIP: Before you set up a custom install, consider which options you want users to see during 
installation. You can make the necessary modifications to the corresponding configuration files 
while making other custom install changes. 

1. Set up the Novell Client Install on a NetWare server. 
2. (Optional) Create a custom configuration (unattend) file. 
3. (Optional) Modify the installation options in the acu.ini file.
4. Deploy the client installation by using the selected method. 

4.2.2  Web Server Installation Options
The following are Web server installation options as described in the Novell Client Installation 
Decision Tree (Figure 4-8 on page 30). 

Web Server Update Agent Default Upgrade (Web Server Decision Tree Option 1)

The following is the procedure required to complete the default Web server upgrade of the Novell 
Client on workstations that already have the Novell Client installed with the Update Agent 
configured. 

1. Set up the Novell Client Install on a Web server. 
2. Launch the Novell Client Update Agent from the Red N menu or automatically.

Web Server Update Agent Custom Upgrade (Web Server Decision Tree Option 2)

The following is the procedure required to complete the custom Web server upgrade of the Novell 
Client on workstations that already have the Novell Client installed with the Update Agent 
configured. 

TIP: Before you set up a custom install, consider which options you want users to see during 
installation. You can make the necessary modifications to the corresponding configuration files 
while making other custom install changes. 

1. Set up the Novell Client Install on a Web server. 
2. (Optional) Create a custom configuration (unattend) file. 
3. (Optional) Modify the installation options in the acu.ini file.
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4. (Optional) Modify the installation options in the cuagent.ini file.
5. Launch the Novell Client Update Agent from the Red N menu or automatically.

Web Server Default Install (Web Server Decision Tree Option 3)

The following is the procedure required to complete the default Web server installation of the Novell 
Client on workstations that already have the Novell Client installed without the Update Agent 
configured. 

1. Set up the Novell Client Install on a Web server. 
2. Create and configure the setupip.exe download executable. 
3. Distribute the download executable.

Web Server Custom Install (Web Server Decision Tree Option 4)

The following is the procedure required to complete the custom Web server installation of the 
Novell Client on workstations that already have the Novell Client installed without the Update 
Agent configured. 

TIP: Before you set up a custom install, consider which options you want users to see during 
installation. You can make the necessary modifications to the corresponding configuration files 
while making other custom install changes. 

1. Set up the Novell Client Install on a Web server. 
2. (Optional) Create a custom configuration (unattend) file. 
3. (Optional) Modify the installation options in the acu.ini file.
4. Distribute the download executable.

Web Server Support Pack Default Install (Web Server Decision Tree Option 5)

The following is the procedure required to complete the default Web server installation of the Novell 
Client Support Pack on workstations that already have the Novell Client installed. 

1. Set up the Novell Client Install on a Web server. 
2. Create and configure the setupip.exe download executable. 
3. Distribute the download executable.

Web Server Support Pack Custom Install (Web Server Decision Tree Option 6)

The following is the procedure required to complete the custom Web server installation of the 
Novell Client Support Pack on workstations that already have the Novell Client installed. 

TIP: Before you set up a custom install, consider which options you want users to see during 
installation. You can make the necessary modifications to the corresponding configuration files 
while making other custom install changes. 

1. Set up the Novell Client Install on a Web server. 
2. (Optional) Create a custom configuration (unattend) file. 
3. (Optional) Modify the Support Pack installation options in the setupsp.inf file. 
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4. (Optional) Modify the installation options in the acu.ini file.
5. Distribute the download executable.

4.3  Novell Client Installation Procedures
This section contains detailed information about the specific procedures required to complete 
various types of network server and Web server installations of the Novell Client. Because each of 
these procedures might apply to several installation types, each process is described separately. For 
more information on how to combine these procedures into a complete installation solution, see 
Section 4.2, “Understanding Which Installation Process to Use,” on page 29. 

4.3.1  Setting Up the Novell Client Install on a NetWare Server
1 On a NetWare server, log in to a server as Admin or as a user with Admin equivalence.

Make sure that you have rights to copy files to a network folder that all users can access, as 
well as rights to modify login scripts.

2 Create a folder in sys:public.
For example:
sys:\public\client

3 Copy the contents of the directory where you unzipped the download file to the folder.
See Section 2.4, “Locating the Latest Client Software,” on page 14.
If you are installing the client in only one language or if your network does not have enough 
space to accommodate multiple language directories, you can delete the language directories 
that you do not need from the nls directory under each client directory. To ensure that you have 
all necessary files, copy the entire client directory and then delete only the extra language 
directories.

4 Create a Group object in the eDirectoryTM tree.
5 Place into that group users whose workstations need to be installed or upgraded.
6 Make sure that the group has the Read and File Scan rights to the folder that you created.

If you created a folder in sys:public, the new folder should have Read and File Scan rights 
already associated with it, but you should make sure that these rights have not been changed.

7 (Conditional) If you want the results of the installation to be added to a status log file, make 
sure that the group has the Write right to that file and enable status logging in the acu.ini or 
cuagent.ini file (see “Modifying the ACU Configuration File” on page 42 or see “Creating 
the Configuration File (Unattend File)” on page 47). If you did not create the status log file 
prior to running the network installation, you must give users the Create and Write rights to the 
directory.
A status log file records the success or failure of the installation. when each workstation 
completes its installation, the status log file is appended to include information on that 
workstation.

8 Complete any additional procedures outlined in the installation type you selected.
For more information on selecting the type of installation needed, see Section 4.2, 
“Understanding Which Installation Process to Use,” on page 29.
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4.3.2  Setting Up the Novell Client Install on a Web Server
Before you can distribute the Novell Client from a Web Server, you must first set up the installation 
directory on the Web server.

1 Create an installation directory on the HTTP Web server where you want users to install from. 
2 Do one of the following: 

Full Novell Client Installs or Upgrades: Copy the context of the directory where you 
unzipped the download file to this directory. For more information on locating the latest 
Novell Client software, see Section 2.4, “Locating the Latest Client Software,” on 
page 14.
For Support Pack Installs: Create the following directory structure:
\sp

and place the Support Pack files in that sp directory.
The IP address specified in the WriteIP utility must be a location on a Web server that 
contains the Support Pack files. If the IP address specified in the WriteIP utility is a 
location on a Web server that contains both the client and the Support Pack files (in an 
overlay), both the client and Support Pack files are downloaded; however, only the 
Support Pack install launches. Creating a directory called sp and placing the Support Pack 
files in that sp directory avoids unnecessary download of Client files. The Web download 
utility downloads only the files in the sp directory and launches the Support Pack install.
You can copy the files to up to five different Web servers in order to provide access during 
peak times. 

IMPORTANT: Ensure that you preserve the case, date, and time of the directories and 
files that are copied to the Web server. This is especially important on Web servers that are 
case sensitive, such as Linux servers.

3 Complete any additional procedures outlined in the installation type you selected.

4.3.3  Creating the setupip.exe Download Executable
You can install the Novell Client software from a Web server. Using the WRITEIP utility, you can 
create a small executable called setupip.exe that downloads the Novell Client install files from a 
Web server and launches the Novell Client install.

1 Run the writeip.exe utility located in the admin directory in the directory where you 
unzipped the download file.
For more information on downloading Novell Client, see Section 2.4, “Locating the Latest 
Client Software,” on page 14.

2 Specify the IP address or DNS name of the Web server and the path to the client files. 
You can specify up to five locations. Each location is checked in the order in which they are 
listed until a connection is made. If you select Choose IP Address at Random, the order in 
which the locations are checked is selected randomly. This balances the load across the Web 
servers. 
For example:
http://111.111.11.1/client

or
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http://mycompany.com/client

3 Specify download options, such as the location for downloading the client installation files.
Files can be downloaded to a temporary or specific directory.
If you select Allow User to Change the Download Directory, the user is prompted for the 
location of the download directory and can change the default location. 
If you do not select Delete Install Files after Install Is Compete, the Novell Client installation 
files remain on the workstation in the specified path or temporary directory.

4 Specify client install launch options.
Support Pack Install: Only the Support Pack software is downloaded and installed, if needed. 
For specific information on setting up the directories correctly on the Web server, see 
Section 4.3.2, “Setting Up the Novell Client Install on a Web Server,” on page 35.
Automatic Client Upgrade: The client install runs only if the client software is a later version 
than the one currently installed on the workstation. For more information, see “Modifying the 
ACU Configuration File” on page 42.
Unattend File: The installation reads the configuration file in order to configure the client 
properties. This file should be placed in the same folder as the installation utility. For more 
information, see “Creating the Configuration File (Unattend File)” on page 47.

5 Click OK.
Setupip.exe is created. Writeip.ini, which stores the options you selected in 
writeip.exe, is also created.

6 Complete any additional procedures outlined in the installation type you selected.
For more information on selecting the type of installation needed, see Section 4.2, 
“Understanding Which Installation Process to Use,” on page 29.

4.3.4  Distributing setupip.exe 
Distribute setupip.exe by placing it on a Web site, sending it through e-mail, or distributing it on a 
diskette. 

When users double-click setupip.exe, the executable downloads the client install files from the 
specified IP address and launches the Novell Client installation.

setupip.exe determines what language version of the client to install based on the settings in the 
Regional and Language Options (Windows XP) or the Regional Options (Windows 2000) dialog 
box in the Control Panel. If the Novell Client supports the language, setupip.exe downloads the /
NLS language files for that language. If the Novell Client does not support the language (that is, the /
NLS files are not available for download), the copy fails with a message to contact the system 
administrator. If the language is not supported by the Novell Client, the English /NLS files must be 
available. For example, this means that you cannot use setupip.exe to force an English language 
version of the Novell Client onto a workstation with German regional settings.
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4.3.5  Setting Up the Novell Client Update Agent

IMPORTANT: This procedure is just one of the tasks required to complete installation of the 
Novell Client on multiple workstations. For more information on how this procedure combines with 
other procedures to create an install method, see Section 4.2, “Understanding Which Installation 
Process to Use,” on page 29. 

You can simplify future client software upgrades by enabling the Novell Client Update Agent. The 
Update Agent can be run manually at any time from the Red N menu or can be run automatically 
when users log in to the network. 

If it is run automatically, the Update Agent determines if the preconfigured number of days have 
elapsed since the last upgrade check and then checks the specified location for a newer version of 
the client. If a newer version is found, the new install is launched. You can preconfigure the interval 
of days as well as the location of the newer client version.

IMPORTANT: Before workstations can check to see if updates are available, the Update Agent 
must be configured during a software installation or by using Automatic Client Upgrade (ACU). Or, 
you can configure the Update Agent on each machine locally through the Novell Client property 
pages. For more information, see Section 4.3.7, “Enabling the Novell Client Update Agent,” on 
page 40.

1 Create a configuration (unattend) file by running the Novell Client Install Manager utility 
(nciman.exe). 
See “Creating the Configuration File (Unattend File)” on page 47.

2 Click Client, then click the Update Agent tab.
3 (Optional) Select the Enable Automatic Update Agent option and set the launch interval. 
4 Select the Update Location option and specify the Update Location path (mapped drive, UNC 

path or URL).
5 (Optional) Select the Previous Install Location option. 

This causes the previous install location to be used if the update location cannot be found. If the 
Update Agent should use only the previous install location, deselect the Update Location 
option.

6 (Conditional) If the user does not have the Administrator right on the workstation, select the 
Administrator Rights option.
Novell Client must be installed by a user that has administrative rights on the workstation. If 
this option is selected, the Update Agent runs as a user with administrative rights and the 
installation is completed. If this option is not selected and the user does not have administrative 
rights, the Update Agent does not run and the user is notified that he or she does not have the 
correct rights.

7 To save the file in the correct location, complete the steps in “Creating the Configuration File 
(Unattend File)” on page 47.

8 Complete any additional procedures outlined in the installation type you selected.
For more information on selecting the type of installation needed, see Section 4.2, 
“Understanding Which Installation Process to Use,” on page 29.
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4.3.6  Modifying the Update Agent Configuration File
1 Locate the cuagent.ini file in the admin directory. 
2 Modify the cuagent.ini file settings, then save the file.

The cuagent.ini file enables you to configure the following settings: 

Option Description Settings

[AgentStatus] Specifies whether the Update Agent is 
configured. If configured, the rest of the .ini 
file is read. If disabled, the Agent does not 
look for an update to the Client

Disabled=Yes | No 
(Default: No)

[LaunchUpdate] Specifies whether the Client Install is 
launched. When this option is set to Yes, the 
Update Agent determines if an update is 
needed and then launches the necessary 
update. When it is set to No, the Update agent 
determines if an update is needed but does 
not launch the necessary update.

Launch=Yes | No 
(Default: Yes)

[Redirection] Specifies a path to redirect the Update Agent 
to a different location for Novell Client files. 
This is useful if you need to locate the files on 
a different server. 

The path can be a mapped drive, UNC path, 
or URL.

You can redirect the Update Agent five times 
(once in each of five different cuagent.ini 
files located in different locations).

Location=path_to_update

[UpdatePrompt] Specifies whether users are prompted to 
begin the update and are notified about the 
location the update will run from.

Display specifies whether users are 
prompted to update Novell Client. 

Display Location specifies whether users 
are notified about the location that the update 
is to run from.

Administrator Message specifies additional 
text that appears when the user is prompted 
to start an update.

Display=Yes | No

DisplayLocation=Yes | No
(Default: No)

AdministratorMessage=
message_from_administrator

[AgentFiles] Specifies whether the Update Agent software 
should be updated before the Novell Client 
update occurs. 

This option lets you update the Update Agent 
if newer software is available with features 
that you want to use or if the Update Agent 
has a defect. Then, the newer Update Agent 
completes the Client software update. 

Update=Yes | No
(Default: No)
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[AgentSettings] Specifies settings located on the Novell Client 
Update Agent property page. If you change 
settings in the cuagent.ini file, these 
changes are made in the Registry and appear 
in the Novell Client Update Agent property 
page. These changes go into effect the next 
time the Update Agent is run.

Update specifies whether the settings are 
transferred from the .ini file to the 
workstation’s registry.

Enable Automatic Update Agent specifies 
whether the Update Agent is launched 
automatically. The Update Agent checks for a 
new version of the Novell Client at the 
designated interval and from the designated 
locations. The Update Agent is launched as a 
part of the login process.

Update Agent Launch Interval sets the 
interval (in days) that the Novell Client Update 
Agent checks for a new version of the Novell 
Client.

Enable Update Location specifies whether 
the Novell Client Update Agent looks for a 
new version of the Novell Client in the 
designated update location.

The Update Agent checks for updates in the 
following order of configured locations: 1) 
Update Location, 2) Previous Install Location.

The Update Agent looks in each configured 
location for valid file types and stops when it 
locates any. Ensure that you have the latest 
files in the first location that the Update Agent 
searches.

Update Location specifies the update 
location (mapped drive, UNC, or URL).

Enable Previous Install Location specifies 
whether the Novell Client Update Agent looks 
for a new version of the Novell Client in the 
previous install location.

Administrator Rights specifies whether the 
Novell Client Update Agent has administrative 
rights on the workstation. The Update Agent 
must have these rights to update the Novell 
Client. This is useful when the user who logs 
in to the workstation is not the workstation 
Administrator user. If this setting is set to No, 
the Update Agent is launched with the rights 
of the currently logged-in user.

Update=Yes | No 
(Default: No)

EnableAutomaticUpdateAgent=
Yes | No 

UpdateAgentLaunchInterval=
interval_in_days

EnableUpdateLocation=Yes | No

UpdateLocation=update_location
_path

EnablePreviousInstallLocation=
Yes | No

AdministratorRights=Yes | No

Option Description Settings
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3 Copy this file to the directory where you unzipped the download file.
4 Complete any additional procedures outlined in the installation type you selected.

For more information on selecting the type of installation needed, see Section 4.2, 
“Understanding Which Installation Process to Use,” on page 29.

4.3.7  Enabling the Novell Client Update Agent
“Enabling the Novell Client Update Agent During a Client Install or Upgrade” on page 40
“Enabling the Novell Client Update Agent by Using ACU Without Installing Novell Client 
Software” on page 41
“Enabling the Novell Client Update Agent on a Local Workstation” on page 41

Enabling the Novell Client Update Agent During a Client Install or Upgrade

1 Select your type of the Novell Client installation.
You must select an install process that allows you to modify the client properties (meaning it 
cannot be a default install type, because the default installs do not modify any configuration 
files or settings). 
For more information on selecting an installation type, see Section 4.2, “Understanding Which 
Installation Process to Use,” on page 29.

2 During the installation process, create a custom configuration (unattend) file to modify the 
properties.
For more information, see “Creating the Configuration File (Unattend File)” on page 47.

[ClientSettings] Update specifies whether the Novell Client 
Update Agent looks for Novell Client property 
page updates.

Unattend File specifies the name of the 
configuration (unattend) file that contains 
property page settings. This file should be in 
the same location as the Update Agent.

Display Prompt specifies whether users are 
prompted to update client settings. 

Display Location specifies whether users 
are notified about the location from which the 
update will run.

Administrator Message specifies additional 
text that appears when users are prompted to 
update.

Update=Yes | No
(Default:No)

UnattendFile=lfile_name

DisplayPrompt=Yes | No
(Default: No)

DisplayLocation=Yes | No
(Default: No)

AdministratorMessage=
message_from_administrator

[StatusLogging] Specifies whether a status log is created and 
where it is located.

Use=Yes | No 
(Default: Yes)

File=log_file_path

Option Description Settings
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3 In the Novell Client Install Manager (nciman.exe), double-click Client, click the Update 
Agent tab, then make the following changes: 
3a Select Enable Automatic Update Agent.
3b (Optional) To launch the Update Agent automatically at a set interval, select Enable 

Automatic Update Agent and then set the launch interval (in days).
If the Update Agent is not set to launch automatically, users can still launch it from the 
Red N menu whenever an update needs to be run. 

3c Specify an update source location.
You can select either a specific location on the network or the previous install location (if 
you intend to place updates in the same location as the last install). The Update Agent 
always looks in the specified location for new files.

4 Continue changing additional configuration settings to create your custom configuration 
(unattend) file, then click OK. 

5 Complete any additional procedures outlined in the installation type you selected.
For more information on selecting the type of installation needed, see Section 4.2, 
“Understanding Which Installation Process to Use,” on page 29.

Enabling the Novell Client Update Agent by Using ACU Without Installing Novell 
Client Software

1 Modify the acu.ini file so that the [UpdateAgentSettings] section of the .ini file is set to 
UPDATE=YES. 
See “Modifying the ACU Configuration File” on page 42 for more information.

2 Change the desired Update Agent settings in the [UpdateAgentSettings] section of the 
acu.ini file. 

3 Run ACU through the login scripts.
See “Distributing the Novell Client by Using Login Scripts” on page 51.

The next time users log in, ACU runs and changes to the Update Agent settings are made. The 
Update Agent is configured and checks for updates as specified in the settings. 

Enabling the Novell Client Update Agent on a Local Workstation

1 At the user's workstation, right-click the Red N icon in the notification area.
2 Click Novell Client Properties.
3 Click the Update Agent tab.
4 Set the properties that you want to change.

TIP: Help for all the Property pages is available directly on the property pages by clicking the 
Question Mark (?) or right-clicking and then selecting What's This? Also, this information and 
additional information on other settings is available in the August 2004 AppNotes® article 
“Novell Client 4.9 SP2: initialization, Login and Settings” (http://www.novell.com/
coolsolutions/appnote/620.html). 

5 Click OK to make the changes and close the property pages.
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4.3.8  Installing Support Packs
The Support Pack installs only a subset of client files and does not require a version change for the 
Client. Support Packs can also be added to the Client (in an overlay manner) to allow the installation 
of both the Client and the Support Pack in one step. Depending on the installation option you use to 
deploy Support Packs, the process differs slightly. 

For example, if you choose one of the Web Server installation options, the IP address specified in 
the WriteIP utility must be a location on a Web server that contains the Support Pack files. If the IP 
address specified in the WriteIP utility is a location on a Web server that contains both the Client and 
the Support Pack files (in an overlay), both the client and Support Pack files are downloaded; 
however, only the Support Pack install launches. Creating a directory called sp in the directory 
where you unzipped the download file and placing the Support Pack files in that sp directory avoids 
unnecessary download of client files. The Web download utility downloads only the files in the sp 
directory and launches the Support Pack install.

In addition, Novell Client property page settings cannot be changed through the default Support 
Pack installation because only a subset of the Novell Client files are changed. If you need to install a 
Support Pack and update properties, you must either complete a full client installation that has the 
Support Pack files in an overlay or use the Update Agent to run both the Support Pack installation 
and update the Novell Client properties. 

For more information on selecting an installation option, see Section 4.2, “Understanding Which 
Installation Process to Use,” on page 29.

4.3.9  Modifying the ACU Configuration File

IMPORTANT: This procedure is just one of the tasks required to complete installation of the 
Novell Client on multiple workstations. For more information on how this procedure combines with 
other procedures to create an install method, see Section 4.2, “Understanding Which Installation 
Process to Use,” on page 29. 

The Automatic Client Upgrade utility (acu.exe) determines whether the client needs to be updated 
and lets you specify several installation options.

1 Open the acu.ini file located in the folder that you created on the server.
2 Modify the configuration options.

IMPORTANT: If you use a configuration (unattend) file to configure the Novell Client and 
you are using acu.exe, you must change the [UNATTENDFILE] option to Yes in the acu.ini 
file.

Option Description Settings

[LaunchInstall] Specifies whether Setup is launched 
after acu.exe determines that the 
installation is necessary.

Launch=Yes | No 
(Default: Yes)

[DisplayDialog] Specifies whether users are prompted 
to begin the upgrade.

Display=Yes | No 
(Default: Yes)
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[UnattendFile] Specifies whether a configuration 
(unattend) file is used and where it is 
located.

Use=Yes | No 
(Default: No)

File=configuration_file_path

[StatusLogging] Specifies whether a status log is 
created and where it is located.

If you did not create a status log file 
prior to installation, it is now created and 
placed in the installation directory on the 
network or in the directory specified in 
the File setting.

Use=Yes | No 
(Default: No)

File=log_file_path

[AdministratorMessage] Specifies additional text that appears 
when the user is prompted to start an 
ACU.

Message=the_message_
you want_to_appear

[ClientLocalInstall] Specifies whether the installation is 
copied to a specified local directory and 
run locally. 

LocalInstall=Yes | No 
(Default: No)

LocalDirectory=directory_
where_you_want_the_
installation_copied 
(Default: 
c:\novell\clientlocalinstall)

DeleteLocalInstall=Yes | No 
(Default: No)

TIP: If you want to delete the 
files after the installation is 
complete, set 
DeleteLocalInstall=Yes.

Option Description Settings
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[UpdateAgentSettings] Specifies the Novell Client Update 
Agent property page settings. 

IMPORTANT: Use this section to set 
the Update Agent settings if you do not 
already have the Update Agent installed 
and configured. If it is installed and 
configured, make changes in the 
cuagent.ini file. 

If you change settings, these changes 
are made in the Registry and appear in 
the Novell Client Update Agent property 
page. These changes go into effect the 
next time the Update Agent is run.

Update specifies whether the settings 
are transferred from the .ini file to the 
workstation’s registry.

Enable Update Agent specifies 
whether the Update Agent is 
configured. This setting specifically 
applies to workstations running Novell 
Client version 4.90 SP2 that are 
upgrading Novell Client software. 
Selecting this option enables the 
Update Agent to perform the software 
update. 

Enable Automatic Update Agent 

specifies whether the Update Agent is 
launched automatically. The Update 
Agent checks for a new version of the 
Novell Client at the designated interval 
and from the designated locations. The 
Update Agent is launched as a part of 
the login process.

Update Agent Launch Interval sets 
the interval (in days) that the Novell 
Client Update Agent checks for a new 
version of the Novell Client.

Enable Update Location specifies 
whether the Novell Client Update Agent 
looks for a new version of the Novell 
Client in the designated update location.

The Update Agent checks for updates 
in the following order of configured 
locations: 1) Update Location, 2) 
Previous Install Location.

Update=Yes | No 
(Default: No)

EnableUpdateAgent=
Yes | No 

EnableAutomaticUpdateAgent=
Yes | No 

UpdateAgentLaunchInterval=
interval_in_days

EnableUpdateLocation=
Yes | No

UpdateLocation=
update_location_path

EnablePreviousInstallLocation=
Yes | No

AdministratorRights=Yes | No

Option Description Settings
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[UpdateAgentSettings] 
continued...

The Update Agent looks in each 
configured location for valid file types 
and stops when it locates them. Ensure 
that you have the latest files in the first 
location that the Update Agent 
searches.

Update Location specifies the update 
location (mapped drive, UNC, or URL).

Enable Previous Install Location 

specifies whether the Novell Client 
Update Agent looks for a new version of 
the Novell Client in the previous install 
location.

Administrator Rights specifies 
whether the Novell Client Update Agent 
has administrative rights on the 
workstation. The Update Agent must 
have these rights to update the Novell 
Client. This is useful when the user who 
logs in to the workstation is not the 
workstation Administrator user. If this 
setting is set to No, the Update Agent is 
launched with the rights of the currently 
logged-in user.

Option Description Settings
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3 Complete any additional procedures outlined in the installation type you selected.
For more information on selecting the type of installation needed, see Section 4.2, 
“Understanding Which Installation Process to Use,” on page 29.

[Uninstall] Specifies which network components 
are uninstalled. Users are prompted to 
reboot after the uninstall is complete. 

IPX specifies whether IPXTM is 
uninstalled.

CMD specifies whether Compatibility 
Mode is uninstalled.

Client specifies whether the Novell 
Client is uninstalled.

NDPS specifies whether Novell 
Distributed Print ServicesTM is 
uninstalled.

Workstation Manager specifies 
whether Workstation Manager, a 
component of ZENworks®, is 
uninstalled.

NAL specifies whether Novell 
Application LauncherTM, a component of 
ZENworks, is uninstalled.

Imaging Service specifies whether 
Imaging Service, a component of 
ZENworks, is uninstalled.

Remote Management specifies 
whether Remote Management, a 
component of ZENworks, is uninstalled.

NICI specifies whether Novell 
International Cryptographic 
Infrastructure (NICI) is uninstalled.

NMAS specifies whether Novell 
Modular Authentication Services 
(NMASTM) is uninstalled.

NetIdentity specifies whether 
NetIdentity is uninstalled.

Administrator Message specifies 
additional text that appears when the 
uninstall begins.

IPX=Yes | No 
(Default: No)

CMD=Yes | No 
(Default: No)

Client=Yes | No 
(Default: No)

NDPS=Yes | No 
(Default: No)

WorkstationManager=Yes | No 
(Default: No)

NAL=Yes | No 
(Default: No)

ImagingService=Yes | No 
(Default: No)

RemoteManagement=Yes | No 
(Default: No)

NICI=Yes | No 
(Default: No)

NMAS=Yes | No 
(Default: No)

NetIdentity=Yes | No 
(Default: No)

AdministratorMessage=
message_from_administrator

Option Description Settings
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4.3.10  Creating the Configuration File (Unattend File)

IMPORTANT: This procedure is just one of the tasks required to complete installation of the 
Novell Client on multiple workstations. For more information on how this procedure combines with 
other procedures to create an install method, see Section 4.2, “Understanding Which Installation 
Process to Use,” on page 29. 

The Novell Client installation reads a configuration (unattend) file generated by the Novell Client 
Install Manager in order to customize the installation process and to configure the Novell Client 
settings. 

Figure 4-9   Novell Client Install Manager

TIP: You can import the settings from a workstation that has been previously configured and save 
them to the configuration file. After you set up the workstation, click File > Import Registry to 
import the settings.

The configuration (unattend) file created by the Novell Client Install Manager provides information 
such as property page settings and installation settings. This file should be placed in the same folder 
as the installation utility.

If you are installing the client with the default settings, you do not need to create or modify the 
configuration files. Skip this process and proceed to Chapter 5, “Setting Client Properties,” on 
page 53.

1 Start Novell Client Install Manager (nciman.exe).
Novell Client Install Manager is located in the \admin folder in the directory that you copied to 
the server.

2 Modify the installation options as needed:
2a In the Configuration Options list box, double-click the installation option that you want to 

modify.
2b On the selected property page, set the parameters and then click OK.
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Description: Novell Client Install Manager Installation Configuration Property Page

The values that you set appear in the Novell Client Install Manager's right list box after 
you close the property page so that you can see a list of all parameters that have been 
modified. 

3 Modify the Client Properties as needed.
For example, if your network uses LDAP, you can enable contextless login. Or, you might want 
to change the welcome screen bitmap. 
For more information on the Client Properties, see Chapter 5, “Setting Client Properties,” on 
page 53 and Chapter 7, “Managing Login,” on page 71. Or, right-click any property to view its 
help information. 

4 Click File > Save.
You can use any filename (for example, unatt_xp.txt).

5 Copy this file to the directory where you unzipped the download file.

IMPORTANT: The path to the text file cannot contain long filenames.

6 Complete any additional procedures outlined in the installation type you selected.
For more information on selecting the type of installation needed, see Section 4.2, 
“Understanding Which Installation Process to Use,” on page 29.

4.3.11  Modifying the Support Pack Configuration File

IMPORTANT: This procedure is just one of the tasks required to complete installation of the 
Novell Client on multiple workstations. For more information on how this procedure combines with 
other procedures to create an install method, see Section 4.2, “Understanding Which Installation 
Process to Use,” on page 29. 
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The Novell Client Support Pack utility lets you control how Support Packs are pushed out to 
workstations by modifying the setupsp.inf file to define install custom settings.

1 Open the setupsp.ini file located in the folder that you created on the server.
2 Modify the Support Pack options section only.

IMPORTANT: Do not change the Client Version and Support Pack Version settings. 

Option Description Settings

Reinstall Specifies whether setupsp.exe 
reinstalls the already installed Support 
Pack on the workstation. 

Yes: Setupsp.exe runs and reapplies 
updates even when the workstation 
already has the current Support Pack 
applied. 

No: Setupsp.exe checks to ensure 
that the Support Pack on the 
workstation is the most current one and 
does not reinstall if it is current. 

Reinstall=Yes | No 
(Default: No)

DisplayInstallPrompts Specifies whether users are prompted 
during the Support Pack installation.

This setting does not affect 
RebootOnCompletion or 
PromptOnCompletion. 

DisplayInstallPrompts=
Yes | No 
(Default: Yes)

UpdateNICI Specifies whether Novell International 
Cryptographic Infrastructure (NICI) is 
updated. 

UpdateNICI=Yes | No 
(Default: YES)

UpdateNMAS Specifies whether Novell Modular 
Authentication Services (NMAS) is 
updated.

UpdateNMAS=Yes | No 
(Default: Yes)

UpdateNetIdentity Specifies whether NetIdentity is 
updated even if an older version is 
detected.

UpdateNetIdentity=Yes | No 
(Default: Yes)
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3 Complete any additional procedures outlined in the installation type you selected.
For more information on selecting the type of installation needed, see Section 4.2, 
“Understanding Which Installation Process to Use,” on page 29.

4.3.12  Selecting a Network Server Distribution Option
After you have set up your network installation of the Novell Client, you must decide how to 
distribute the install files. You can modify the login script to launch installation files, distribute the 
files through ZENworks, or use another method you have available on your network. 

RebootOnCompletion Specifies whether the workstation is 
rebooted after the Support Pack install 
is completed.

Prompt: Users are prompted to decide 
whether or not to reboot the 
workstation. 

NOTE: The PromptUserOnCompletion 
setting has no affect if 
RebootOnCompletion is set to Prompt.

Yes: The workstation is rebooted upon 
completion. This setting can be used in 
conjunction with the 
PromptUserOnCompletion setting to 
force the reboot and alert users that the 
reboot must occur. 

No: The workstation is not rebooted 
upon completion. This setting can be 
used in conjunction with the 
PromptUserOnCompletion setting to 
advise the user that the update is 
complete. However, there is no forced 
or prompted reboot of the workstation. 

RebootOnCompletion=
Prompt | Yes | No 
(Default: Prompt)

PromptUserOnCompletion Specifies whether users are prompted 
that a update has occurred and 
(optional) that the workstation needs to 
be rebooted.

Yes: Displays a prompt explaining that 
the update is completed. If this setting 
has been used in conjunction with 
RebootOnCompletion=Yes, the 
workstation is rebooted when the user 
clicks OK.

No: Does not display a prompt for 
users. If this setting has been used in 
conjunction with 
RebootOnCompletion=Yes, the 
workstation is rebooted without 
warning.

PromptUserOnCompletion=
Yes | No 
(Default: Yes)

Option Description Settings
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For more information on using login scripts, see “Distributing the Novell Client by Using Login 
Scripts” on page 51. For more information on using ZENworks, see the documentation associated 
with the installed version of ZENworks. 

Distributing the Novell Client by Using Login Scripts

IMPORTANT: This procedure is just one of the tasks required to complete installation of the 
Novell Client on multiple workstations. For more information on how this procedure combines with 
other procedures to create an install method, see Section 4.2, “Understanding Which Installation 
Process to Use,” on page 29. 

Keep in mind the following considerations as you work with login scripts:

You need to modify login scripts for users whose workstations are upgraded.
To upgrade workstations for users in a container, modify that container's login script.
To upgrade workstations for users in a profile, modify that profile's login script.
To upgrade specific users' workstations, modify those users' login scripts.
To upgrade a workstation running bindery-based client software (such as Microsoft Client for 
NetWare Networks which ships with Windows 95 or Windows 98), edit the system login script 
(sys:public\net$log.dat).

You can create or modify a user login script using either ConsoleOne® or iManager.

“Using iManager” on page 51
“Using ConsoleOne” on page 51
“Sample Client Installation Login Script” on page 52

Using iManager

1 Click Roles and Tasks > User Management > Modify User. 
2 Specify a username and context, then click OK. 
3 Click General > Login Script.
4 Type the login script commands and information in the login script text box.

For a sample of the login script commands that you need to add to the scripts, see “Sample 
Client Installation Login Script” on page 52.

IMPORTANT: Make sure that you edit the sample login script to match the server names, 
directory paths, and specifications of your own network.

For additional information on all login script commands, see the Novell Login Scripts Guide 
(http://www.novell.com/documentation/linux_client/login/data/front.html).

5 To save the login script, click OK.

Using ConsoleOne

1 Double-click the object whose login script you want to create or modify.
2 Click Login Script.
3 Type the login script commands and information into the login script text box.
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For a sample of the login script commands that you need to add to the scripts, see “Sample 
Client Installation Login Script” on page 52.

IMPORTANT: Make sure that you edit the sample login script to match the server names, 
directory paths, and specifications of your own network.

For additional information on all login script commands, see the Novell Login Scripts Guide 
(http://www.novell.com/documentation/linux_client/login/data/front.html).

4 To save the login script and close the Details dialog box, click OK.
If the login script that you just created was a container or user login script, you're finished and 
the client software installs or updates the next time users log in.
If the login script that you just created was for a Profile object, you must associate the User 
object with the Profile object and make the User object a trustee of the Profile object. See 
“Getting Around the One User and One Profile Login Script Restriction” (http://
www.novell.com/documentation/linux_client/login/data/hq16v3gw.html#hs5zi9ik) in the 
Novell Login Scripts Guide.

Sample Client Installation Login Script

The following sample shows the commands that you add to the login script in order to install the 
client software from the network. The sample includes text for installing across an internal network.

NOTE: In this sample, the text that is necessary to the script is represented in uppercase letters. The 
information that you should customize for your network is in lowercase letters.

REM ***** Windows 2000/XP *****
IF OS = “winnt”
   WRITE “Updating Novell Client for Windows 2000/XP.”
   #\\server1\sys\public\client\acu.exe
   IF “%ERROR_LEVEL” = “1” THEN
        EXIT
   END
END
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5Setting Client Properties

You can optimize the Novell® ClientTM for your network by using property pages to configure 
protocol support, optimize performance, configure optional client parameters, and set a variety of 
other parameters.

By default, the client is configured for high speed with moderate use of memory and data protection. 
You can adjust the client to optimize its performance in any of these areas. However, optimizing the 
client in one area might lessen performance in other areas.

TIP: Help for all the property pages is available directly on the pages by clicking the question mark 
(?) or right-clicking and then selecting What's This? Also, this information and additional 
information on other settings is available in the August 2004 AppNotes® article “Novell Client 4.9 
SP2: Initialization, Login and Settings” (http://www.novell.com/coolsolutions/appnote/620.html). 
Also, a short description of each Advanced Menu setting is available in the Description field when 
you select the option.

This section discusses the following ways to set properties:

Section 5.1, “Setting Properties During Installation,” on page 53
Section 5.2, “Setting Properties on a Single Workstation after Installation,” on page 54
Section 5.3, “Setting Properties on Multiple Workstations after Installation,” on page 54
Section 5.4, “Using DHCP,” on page 55

5.1  Setting Properties During Installation
Use the Novell Client Install Manager to set properties for one or more workstations before an 
unattended install. This method saves you from having to set each workstation individually.

1 Start the Novell Client Install Manager (nciman.exe) located in the admin folder in the 
directory where you unzipped the download file.

2 Modify the installation options as needed.
2a Double-click the configuration option that you want to modify in the Installation 

Configuration list box.
2b In the property pages, set the parameters and then click OK.

The values that you set appear in the right list box.

TIP: You can set up one workstation the way you want other workstations to be set up, 
then use the Novell Client Install Manager to import the settings from that workstation's 
registry and save them to the configuration file you will use during the ACU install. After 
you set up the workstation, click File > Open Registry to import the settings into the 
Novell Client Install Manager.
For information about setting properties on a single workstation, see Section 3.3, 
“Configuring Network Protocols,” on page 18.

3 Click File > Save.
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You can save the file with any filename that you want to use. For example, you could rename 
the file novell.txt and then use it in conjunction with an installation method: 

In an installation type using ACU with the file name specified.
For more information, see Chapter 4, “Installing and Upgrading the Novell Client on 
Multiple Workstations,” on page 21.
At the command line by specifying the filename with the /U option.
For more information, see Chapter 3, “Installing the Novell Client on a Single 
Workstation,” on page 17.
In the Web installation executable created by writeip.exe.
For more information, see Section 4.3.3, “Creating the setupip.exe Download 
Executable,” on page 35.

5.2  Setting Properties on a Single Workstation 
after Installation

1 At the user's workstation, right-click the Red N icon in the notification area.
2 Click Novell Client Properties.
3 Set the properties that you want to change.

Help for all the property pages is available directly on the pages by clicking the question mark 
(?) or right-clicking and then selecting What's This? This information and additional 
information on other settings is also available in the August 2004 AppNotes article “Novell 
Client 4.9 SP2: Initialization, Login and Settings” (http://www.novell.com/coolsolutions/
appnote/620.html).

4 Click OK to set the changes and close the property pages.

5.3  Setting Properties on Multiple Workstations 
after Installation
You can also set properties on multiple workstations after installation using the Novell Client 
Update Agent. 

1 Make sure that Update Agent is configured on each workstation and that the Update Location 
has been specified. 
You can check the Update Agent settings in the Novell Client Properties dialog box (right-click 
the Red N icon on the status bar > Novell Client Properties > Update Agent).
Update Agent can be configured during installation or after installation by enabling it on each 
workstation or using Automatic Client Upgrade. See “Enabling the Novell Client Update Agent 
on a Local Workstation” on page 41 or “Enabling the Novell Client Update Agent by Using 
ACU Without Installing Novell Client Software” on page 41.

2 Using the Novell Client Install Manager, create a configuration (unattend) file with the desired 
property settings.

3 Copy the configuration (unattend) file to the directory in the update location. 
4 Copy the cuagent.ini file from the admin directory to the directory in the update location.
5 Modify the cuagent.ini file in the update location so that the [ClientSettings] section has 

the following settings:
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Update=YESUnattendFile=name_of_the_unattend_file

Replace name_of_the_unattend_file with only a filename, as the Update Agent does not accept 
paths. The file must exist in the directory that the Update Agent is trying to update from. 

6 (Optional) Make any additional changes to the cuagent.ini file. 
For example, you might want to modify the Display Prompt or Administrator Message settings. 

7 Run the Update Agent from the workstation. 
See “Setting Up the Novell Client Update Agent” on page 37. 

After settings are updated, the pathname, date, and time of the configuration (unattend) file is 
displayed in the Last Client Configuration Settings File on the Update Agent Property Page. 

5.4  Using DHCP
If a DHCP server is set up on your network, the DHCP server can inform the Novell Client of 
network-specific configuration information.

You can easily configure Novell DHCP servers (NetWare® 5 and later) to distribute this information 
to the clients. See the Novell DNS/DHCP Services for NetWare Administration Guide (http://
www.novell.com/documentation/oes/dhcp_enu/data/front.html) for more information.

Clients obtain configuration information from DHCP even when you statically configure the clients' 
IP addresses or even when the DHCP server used to supply the information is different from the 
DHCP server supplying an IP address to the clients.

5.4.1  Using DHCP as an eDirectory Server Name Service 
Provider
You can set up a DHCP server to inform Novell Client workstations that use the IP protocol about an 
eDirectoryTM tree name and the IP addresses of servers that are on that tree. When using this feature, 
it is best to specify the IP addresses of the closest eDirectory servers containing partitions with the 
user information.

5.4.2  Using DHCP to Distribute SLP Configuration Information
You can configure the following SLP parameters through DHCP:

IP Address of SLP Directory Agents 
SLP Scopes

5.4.3  Using DHCP to Distribute IPX Compatibility Information
You can configure the following IPXTM compatibility parameters through DHCP:

IP Address of Migration Agents
CMD Network Number
Migration Agent List Stale Time
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6Managing File Security and 
Passwords

This section explains the following:

Section 6.1, “NetWare File Security,” on page 57
Section 6.2, “Managing Passwords,” on page 58
Section 6.3, “Using Forgotten Password Self-Service,” on page 61
Section 6.4, “Setting Up Passwords in Windows,” on page 66
Section 6.5, “Setting Up AutoAdminLogon for Windows,” on page 66

6.1  NetWare File Security
Novell® NetWare® networks restrict access to network files and folders based on user accounts. For 
example, a user connected to the network through an Administrator account might be able to delete 
or rename a file that other users can only open and edit.

The NetWare file system keeps track of the rights that users have to files and directories on the 
network. When users try to access any file on a NetWare network, NetWare either grants access or 
prohibits certain things that users can do with the file.

Rights are granted and revoked by creating trustee assignments. For more information, see 
“Changing Trustee Assignments” on page 57.

File rights apply only to the file that they are assigned to. The rights can be inherited from the folder 
that contains the file. Folder rights apply not only to the folder but also to the files and folders it 
contains.

Section 6.1.1, “Checking File or Folder Rights,” on page 57
Section 6.1.2, “Changing Trustee Assignments,” on page 57
Section 6.1.3, “Combining Multiple Trustees,” on page 58

6.1.1  Checking File or Folder Rights
1 In Windows Explorer or My Network Places, right-click the file that you want to check.
2 Click Properties > NetWare Rights.
3 In the Trustees box, click the user account. 

The rights to the file or folder are displayed on the right side.

6.1.2  Changing Trustee Assignments
You must have the Access Control right to change trustee assignments.

1 In Windows Explorer or My Network Places, right-click the file that you want to check.
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2 Click Properties > NetWare Rights.
3 Add trustees, remove trustees, or change the rights granted to trustees as needed.

Trustee assignments override inherited rights.

To change an Inherited Rights Filter, click the Inherited Rights and Filters button on the NetWare 
Rights property page.

6.1.3  Combining Multiple Trustees
As an administrator, you might need to apply the same trustee assignments to a group of selected 
files. You can combine trustee assignments by selecting the Combine Multiple Trustees option on 
the NetWare Rights page.

1 In Windows Explorer or My Network Places, click a file.
2 Press and hold Control while clicking additional files.
3 Right-click the selected files.
4 Click Properties > NetWare Rights.

The Combine Multiple Trustees option is enabled.
This option is available only if you're viewing the NetWare rights for multiple files or folders. 
Additionally, at least one of the files or folders must have at least one trustee assignment. The 
trustees and rights shown are the combined trustees and rights for all the files.

5 Select or deselect the Combine Multiple Trustees option.
If you select this option, the trustee assignments that are shown are applied to all selected files 
after you click OK or Apply.
For example, Kim is a trustee of file_a and file_b. Kim has Read, File Scan, and Access 
Control rights for file_a and Read and File Scan rights for file_b. If you select file_a and file_b 
and view their properties, Kim is shown as a trustee with Read, File Scan, and Access Control 
rights.
If you select Combine Multiple Trustees and then click OK, Kim is given the Access Control 
right for file_b. Therefore, Kim now has Read, File Scan, and Access Control rights for both 
file_a and file_b.

6 Click OK or Apply.

6.2  Managing Passwords
Starting with NetWare 6.5 and eDirectoryTM 8.7.3, Novell provides password management tools that 
help administrators secure the network with stronger passwords and reduce password management 
by enabling end users to manage their own passwords. This set of tools is referred to as Universal 
Password. 

With Universal Password, users can employ a single username and password to access networks, 
applications, devices, Internet sites, online services, portals, and more. Administrators can reduce or 
eliminate the mundane task of resetting user passwords when they are forgotten or lost. Universal 
Password also manages multiple types of password authentication methods from disparate systems 
and provides extended password management capabilities. Universal Password is made possible by 
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Novell Modular Authentication Services (NMASTM) advanced authentication technology that allows 
for multiple methods of authentication, including simple passwords, smart cards, biometrics, tokens, 
and digital certificates.

Universal Password uses eDirectory plus NMAS to create just that—a “universal password” that is 
used for access to all resources. This password takes the place of the combination of simple 
passwords, NDS® passwords, and enhanced passwords in eDirectory, and allows for the 
enforcement of strong password policies, such as minimum or maximum number of characters, a 
combination of alphabetic and numeric characters, and forced password reset.

In addition, password policies let users set a hint for their passwords. If a password is entered 
incorrectly or is forgotten, users can click Did you forget your password? and retrieve the hint they 
entered to help them remember their password. This reduces administrator time spent resetting 
forgotten passwords. 

For more information on deploying universal passwords, see the Universal Password Deployment 
Guide in the Novell Modular Authentication Services 3.0 Administration Guide (http://
www.novell.com/documentation/nmas30/admin/data/allq21t.html) and “Managing Passwords by 
Using Password Policies” (http://www.novell.com/documentation/password_management/
pwm_administration/data/ampxjj0.html) in the Novell Password Management Administration 
Guide. It is important that you understand the requirements for using these advanced password 
policies before rolling out any password changes to your network. 

The Novell ClientTM takes advantage of several of the features provided in Universal Passwords, 
including

Stronger password policies set in iManager.
Display of password requirements on the Change Passwords screen so that users know what 
policies you have set for passwords.
Access to password hints to help users remember their passwords. 
Support for changing passwords. 
Challenge/response for password reset. 

6.2.1  Creating Strong Passwords
Password policies allow you to set strong password policies such as minimum or maximum number 
of characters, a combination of alpha and numeric characters, and forced password reset. You set 
password policies in Novell iManager and then assign them to users. Administering passwords by 
using Novell iManager automatically sets the Universal Password to be synchronized to simple and 
NDS password values for backwards compatibility. The NMAS task in iManager allows for granular 
management of individual passwords and authentication methods that are installed and configured 
in the system. 

For more information on setting up password policies in iManager, see “Managing Passwords by 
Using Password Policies” (http://www.novell.com/documentation/password_management/
pwm_administration/data/ampxjj0.html) in the Novell Password Management Administration 
Guide. Make sure that you read this documentation and understand the requirements before rolling 
out any password changes to your network. 
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Then, use the Password Policy Wizard in iManager to set up the policies.

1 Make sure you have completed the steps in “Prerequisites for Using Password Policies” (http://
www.novell.com/documentation/password_management/pwm_administration/data/
bo59drg.html#bo59drg) in the Novell Password Management Administration Guide. These 
steps prepare you to use all the features of password policies.

2 In iManager, click Password Management > Manage Password Policies.
3 Click New to create a new Password policy.
4 Follow the steps in the wizard to create Advanced Password Rules, Universal Password 

Configuration Options, and Forgotten Password selections for the policy.

For information about each step, see the online help as well as the information in “Managing 
Passwords by Using Password Policies” (http://www.novell.com/documentation/
password_management/pwm_administration/data/ampxjj0.html) in the Novell Password 
Management Administration Guide.

6.2.2  Displaying Password Requirements for End Users
Password policies ensure that passwords adhere to administrator-defined criteria. The user can 
examine these criteria by clicking the Password Policy or Policy button in any of the Change 
Password dialog boxes.

Figure 6-1   Change Password Dialog Box
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Figure 6-2   Change Expired Password Dialog Box

The following is an example of the password criteria displayed in the Novell Client Password Policy 
dialog box. 

Figure 6-3   Novell Client Password Policy Dialog Box

6.3  Using Forgotten Password Self-Service
You can use the Password Policy Wizard in iManager to create a Password policy, which provides 
users with the ability to recover from a forgotten password without contacting the help desk.

The following features are supported:

Using the “Did You Forget Your Password?” Link (page 62)
Using Hints for Remembering Passwords (page 65)
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IMPORTANT: Before using Password Self-Service, review the information in “Managing 
Passwords by Using Password Policies” (http://www.novell.com/documentation/
password_management/pwm_administration/data/ampxjj0.html) in the Novell Password 
Management Administration Guide.

6.3.1  Using the “Did You Forget Your Password?” Link
When you click the Did you forget your password? link in the Novell Login dialog box, the system 
invokes the Forgotten Password Policy specific to the user. The following three options are 
supported by the Novell Client for Windows: 

Display a password hint.
Authenticate via Challenge Response and show a password reminder (requires eDirectory 8.8 
or later).
Authenticate via Challenge Response and reset the password.

NOTE: Not all features of Forgotten Password Self-Service are implemented with the Novell 
Client at this time, including e-mailing passwords and hints.

Figure 6-4   Novell Client Login Dialog Box

NOTE: The Did you forget your password? link is available in Novell Client 4.91 Support Pack 2 
and later. Beginning in SP2, the Client prompts users to populate the Challenge Response set if they 
log in and the sets have not been entered.

The workstation administrator can choose to display or not display the Did you forget your 
password? link on the Novell Login dialog box.

1 Right click the Red N, then click Novell Client Properties.
2 Click the Advanced Login tab.
3 Set the Forgotten Password Prompt option to On or Off.

Before the Did you forget your password? link can work, you must complete the following:

“Configuring Password Self-Service” on page 63
“Configuring Challenge/Response Settings” on page 63
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If you click the link before Password Self-Service is set up, you receive an error. If the administrator 
changed or set up a new policy, you are prompted on log in.

Configuring Password Self-Service

Before users can use the Did you forget your password? link, the administrator must configure 
Password Self-Service and the user must enter the password hint or responses to challenge 
questions. The administrator should also upgrade to eDirectory 8.8 or later. See “Password Self-
Service” (http://www.novell.com/documentation/password_management/pwm_administration/data/
bqf5d1r.html) in the Novell Password Management Administration Guide for more information.

Configuring Challenge/Response Settings

After the administrator configures the challenge sets and password policies, users need to provide 
their information for the challenge sets in either of the following two ways:

Right-click the Red N, then click User Administration > Challenge/Response Administration. 
Depending on how the administrator configured the challenge sets, users enter their 
information in the dialog boxes presented. For example, if the administrator specifies three 
questions in the challenge set, users enter information in three different dialog boxes.
If the administrator selected the Force user to configure Challenge Questions and/or Hint upon 
authentication option on the Forgotten Password page in iManager, the Client prompts users to 
enter this information when they log in and when their challenge set information is missing or 
out of date.
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Figure 6-5   Forgotten Password Page in iManager

The challenge/response questions allow for any response, such as a word, a sentence, or a phrase. 
Because it might be difficult to correctly type a phrase or sentence when the text is hidden, answers 
are not hidden with asterisks by default, like passwords usually are. However, as an added layer of 
security, you can configure the challenge/response LCM to hide the user’s responses to the 
challenge questions. For example, when this functionality is enabled, instead of the user’s response 
reading “my son charlie” in plain text, the response reads “** *** *******.”

To configure the challenge/response LCM to hide the user’s responses to the challenge questions:

1 Create the following registry key:
HKLM\SOFTWARE\Novell\NMAS\MethodData\challenge_response

2 Create a DWORD registry value named mask_responses, and set it to one of the following 
values:
0 - FALSE, don’t mask responses (default value)
1- TRUE, mask responses

If a user forgets the answers to his or her challenge/response questions, the Novell Client does 
provide a way to reset the answers. Right-click the Red N icon, then click User Administration for > 
Challenge/Response Administration. The user can then enter new responses in the dialog boxes 
presented.
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6.3.2  Using Hints for Remembering Passwords
If you specify a forgotten password action that requires a password hint, users are required to enter a 
hint that is a reminder of the password. The password hint is checked to make sure that it does not 
contain the user’s password. Users must enter a new hint every time they change their passwords.

Figure 6-6   Define Password Hint Dialog Box

If a user clicks the Did you forget your password? link on the Novell Login screen, a dialog box 
containing the password hint is displayed.

Figure 6-7   Forgotten Password Hint Dialog Box

If a user enters an erroneous password, the login program displays an error message, prompting 
them to retype their password or click the Did you forget your password? link.

Figure 6-8   Password Error Dialog Box

If the policy action is to show a hint but the user did not enter a hint for their current password, an 
error message is displayed telling the user to contact their system administrator to reset their 
password and to enter a hint the next time they set their password.
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Figure 6-9   Forgotten Password Error Dialog Box

Users can also create a hint at any time using the Change Password window available at login or by 
pressing Ctrl+Alt+Delete then clicking Change Password. 

Figure 6-10   Change Password Dialog Box

6.4  Setting Up Passwords in Windows
We recommend that you configure workstations to not use any of the Microsoft password 
restrictions available in User Manager. Novell Client works best if password restrictions are set in 
eDirectory.

6.5  Setting Up AutoAdminLogon for Windows
Windows 2000 and Windows XP can automate the logon process by storing passwords and other 
pertinent information in the Registry database.

WARNING: There is a security risk to using the AutoAdminLogon feature. Usernames and 
passwords in the registry are visible to users. This feature also allows other users to start the 
computer and use the account to automatically log in even if the workstation is locked. Refer to the 
Microsoft recommendations on when to use AutoAdminLogon. For more information, see TID # 
10052847 at the Novell Support Web site (http://support.novell.com/cgi-bin/search/
tidfinder.cgi?10052847).

Use Registry Editor (regedit.exe) to add the needed logon information. 
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WARNING: Using Registry Editor incorrectly can cause serious, system-wide problems that might 
require reinstalling Windows.

TIP: To bypass the AutoAdminLogon process, and to log in as a different user, hold down the Shift 
key after a logout or after a Windows restart.

Section 6.5.1, “AutoAdminLogon Options,” on page 67
Section 6.5.2, “Setting the AutoAdminLogon Options,” on page 69
Section 6.5.3, “Changing Passwords in NetWare Login with AutoAdminLogon,” on page 70

6.5.1  AutoAdminLogon Options
This section lists the options that you can choose from when setting AutoAdminLogon. To set the 
options, use the procedure in “Setting the AutoAdminLogon Options” on page 69.

Additional information on AutoAdminLogon is also available in Technical Information Document # 
10052847 on the Novell Support Web Site (http://www.novell.com/support).

“For a Windows Workstation Only” on page 67
“For a Windows Workstation and NetWare” on page 68
“For NetWare Only Using Dynamic Local User (DLU) for Windows” on page 68
“For Windows with Query for NetWare” on page 69
“For NetWare under Terminal Server” on page 69
“Turn Off AutoAdminLogon” on page 69

For a Windows Workstation Only

Key: hkey_local_machine\software\microsoft\
windowsnt\currentversion\winlogon Key: hkey_local_machine\software\novell\ login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=Name of 
Domain or Local Workstation

DefaultUserName=Windows User Name

DefaultPassword=Windows Password for the 
DefaultUserName specified above

AutoAdminLogon=0
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For a Windows Workstation and NetWare

Location profiles let you save a user's specific login information. The profile automatically sets up 
login information such as the user's name, server, tree, context, login script, and other applicable 
information so that the user does not have to type this information. For more information, see 
Section 7.3, “Setting Up Location Profiles,” on page 72.

NOTE: The Credential information in the Location Profile is not used. The user information in the 
registry is used instead.

For NetWare Only Using Dynamic Local User (DLU) for Windows

Location profiles let you save a user’s specific login information. The profile automatically sets up 
login information such as the user’s name, server, tree, context, login script, and other applicable 
information so that the user does not need to type this information. In this case, the location profile 
must specify an eDirectory user with Dynamic Local User (DLU) privileges on the Windows 
workstation. For more information, see Section 7.3, “Setting Up Location Profiles,” on page 72. 

Key: hkey_local_machine\software\microsoft\
windowsnt\currentversion\winlogon Key: hkey_local_machine\software\novell\ login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=Name of 
Domain or Local Workstation

DefaultUserName=Windows User Name

DefaultPassword=Windows Password for the 
DefaultUserName specified above

AutoAdminLogon=1

DefaultLocationProfile=Name of the Location 
Profile that contains the information about the 
Novell User to log in to the NetWare network such 
as Username, Tree, Context, and Server.

DefaultPassword=Novell Password for the 
DefaultUserName specified in the Location Profile

Key: hkey_local_machine\software\microsoft\
windowsnt\currentversion\winlogon Key: hkey_local_machine\software\novell\ login

AutoAdminLogon=0 AutoAdminLogon=1

DefaultLocationProfile=Name of the Location 
Profile that contains the information about the 
Novell User to log in to the NetWare network such 
as Username, Tree, Context, and Server.

DefaultPassword=Novell Password for the 
DefaultUserName specified in the Location Profile
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For Windows with Query for NetWare

For NetWare under Terminal Server

Turn Off AutoAdminLogon

6.5.2  Setting the AutoAdminLogon Options
1 Start Registry Editor (regedit.exe).
2 Locate the specified Registry keys and set the values as indicated.

If a value does not exist, click Edit > New > String Value, type the name of the value, and then 
press Enter. All the values should be string values except for AutoAdminQueryNDS, which 
must be a DWORD value instead of a string value. 

IMPORTANT: If no DefaultPassword string is specified, the value of the AutoAdminLogon 
key is automatically changed from 1 (True) to 0 (False), disabling the AutoAdminLogon 
feature.

3 Exit the Registry Editor and log out of Windows.

Key: hkey_local_machine\software\microsoft\
windowsnt\currentversion\winlogon Key: hkey_local_machine\software\novell\ login

AutoAdminLogon=1

DefaultDomain or Local WorkstationName=Name of 
Domain or Local Workstation

DefaultUserName=Windows User Name

DefaultPassword=Windows Password for the 
DefaultUserName specified above

AutoAdminLogon=0

AutoAdminQueryNDS=1

IMPORTANT: AutoAdminQueryNDS must be a 
DWORD value instead of a string value. 

Key: hkey_local_machine\software\microsoft\
windowsnt\currentversion\winlogon Key: hkey_local_machine\software\novell\ login

 AutoAdminLogon=1

DefaultLocationProfile=Name of the Location 
Profile that contains the information about the 
Novell User to log in to the NetWare network such 
as Username, Tree, Context, and Server.

DefaultPassword=Novell Password for the 
DefaultUserName specified in the Location Profile

Key: hkey_local_machine\software\microsoft\
windowsnt\currentversion\winlogon Key: hkey_local_machine\software\novell\ login

AutoAdminLogon=0 AutoAdminLogon=0
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6.5.3  Changing Passwords in NetWare Login with 
AutoAdminLogon
If AutoAdminLogon is enabled, be careful when running the NetWare Login utility from the icon in 
the NetWare (Common) group. When run as a standalone utility from the icon, NetWare Login does 
not recognize that the workstation is running AutoAdminLogon.

If the primary connection's password expires when running NetWare Login from the icon, the user is 
given the chance to synchronize all NetWare and Windows passwords. Make sure that users do not 
synchronize the Windows password, because NetWare Login does not update the Registry setting 
for AutoAdminLogon.
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7Managing Login 

This section contains information on customizing the Novell® ClientTM login environment to suit 
your network and give you greater control over what users can access during login.

Section 7.1, “Setting Up Login Scripts,” on page 71
Section 7.2, “Setting Up Login Restrictions,” on page 71
Section 7.3, “Setting Up Location Profiles,” on page 72
Section 7.4, “Customizing the Novell Login Dialog Box,” on page 74
Section 7.5, “Configuring 802.1X Authentication,” on page 77
Section 7.6, “Enabling Passive Mode Login,” on page 81
Section 7.7, “Logging In to the Network,” on page 82
Section 7.8, “Logging Out of the Network,” on page 83
Section 7.9, “Setting Up LDAP Contextless Login and LDAP Treeless Login,” on page 83

7.1  Setting Up Login Scripts
When a user successfully logs in to the network, one or more login scripts are executed that 
automatically set up the workstation environment. Login scripts are similar to batch files and are 
executed by the Novell Login utility. You can use login scripts to map drives and search drives to 
directories, display messages, set environment variables, and execute programs or menus.

For more information on setting up login scripts, see the Novell Login Scripts Guide (http://
www.novell.com/documentation/linux_client/login/data/front.html).

7.2  Setting Up Login Restrictions
Login restrictions are limitations on user accounts that control access to the network. These 
restrictions can be set in Novell iManager or ConsoleOne® for each user and include the following:

Requiring a password 

You can specify its minimum length, whether it must be changed and how often, whether it 
must be unique, and whether the user can change it. You can also require strong passwords. See 
Section 6.2, “Managing Passwords,” on page 58. 
Setting the number of logins with an expired password and the number of incorrect login 
attempts allowed
Setting account limits such as an account balance or expiration date
Limiting disk space for each user by specifying the maximum blocks available for each user on 
a volume
Specifying the number of simultaneous connections a user can have
Specifying (by node address) which workstations users can log in on
Restricting the times when users can log in (you can assign all users the same hours, or you can 
restrict users individually)
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When a user violates login restrictions by entering an incorrect password or the exceeding the 
number of logins with an expired password, the account is disabled and no one can log in using that 
username. This prevents unauthorized users from logging in.

7.3  Setting Up Location Profiles
Location profiles let you save the information from a user's specific login to a location profile. When 
the user selects this profile during login, the profile automatically sets up login information such as 
the user's name, server, tree, context, login script, and other applicable information so that the user 
does not have to type this information.

Location profiles are especially powerful for users who log in from multiple places. Users can have 
separate profiles for the office, home, laptop, or any other workstation they use. This simplifies the 
login process so that users do not need to remember their login information for each workstation. 
Using multiple location profiles also gives you control over what users can access from each 
workstation.

You can create location profiles on a single workstation that are specifically customized for that 
user, or you can create location profiles that are more general in nature to be delivered during 
installation of the Novell Client for Windows using the Novell Client Install Manager.

Section 7.3.1, “Creating a Location Profile on a Specific Workstation,” on page 72
Section 7.3.2, “Creating a Location Profile for Use on Multiple Workstations,” on page 73
Section 7.3.3, “Removing a Location Profile,” on page 74

7.3.1  Creating a Location Profile on a Specific Workstation 
1 Right-click the Red N icon on the status bar, then click Novell Client Properties > Location 

Profiles.
 Client 4.91 SP5 for Windows XP/2003 Installation and Administration Guide



novdocx (en)  16 A
pril 2010
Description: Location Profiles Tab

2 Type the name of the profile that you want to add, then click Add.
3 From the Service menu, select one of the following:

Login Service (to configure login settings)
Connection Service (to configure your dial-up connection settings)

4 From the Service Instance menu, do one of the following:
Select an existing service instance.
Type a name for a new service instance, then click Add to specify the settings for this 
service in the Novell Client Login window or Connection Services window.

5 Click OK.

7.3.2  Creating a Location Profile for Use on Multiple 
Workstations
Location Profiles are one of many settings that can be predefined using a custom (unattend) 
configuration file that is applied during installation of the Novell Client. For more information, see 
“Creating the Configuration File (Unattend File)” on page 47.

To create a location profile to be distributed by Novell Client Install Manager:

1 Start the Novell Client Install Manager to create a custom (unattend) file. 
2 In the Configurations Options window, click Client > Location Profiles. 
3 Type the name of the profile that you want to add, then click Add.
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4 From the Service menu, select one of the following:
Login Service (to configure login settings)
Connection Service (to configure your dial-up connection settings)

5 From the Service Instance menu, do one of the following:
Select an existing service instance.
Type a name for a new service instance, then click Add to specify the settings for this 
service in the Novell Client Login window or Connection Services window.

6 Click OK.
7 In the NCIMAN Parameter list, right-click the location profile, click Distribute, then select 

whether to append or replace any existing location profiles already on the workstations. 
Appending an existing location profile merges the settings in this file with the settings that exist 
in the location profile already on a workstation. Replacing overwrites any existing location 
profile with this one. 
By default, the new location profile item is automatically appended to any location profile that 
might exist on a workstation. 

WARNING: If you right-click and select Clear List and Distribute, the location profile you 
just created is deleted. 

8 Continue creating the configuration file. 
For more information, see “Creating the Configuration File (Unattend File)” on page 47.

This file will be applied during the next client installation or can be run from a login script, by ACU, 
or by Update Agent. For more information on distribution methods, see Section 4.3.12, “Selecting a 
Network Server Distribution Option,” on page 50 and Section 4.1.1, “Understanding the Basic 
Novell Client Installation (setupnw.exe),” on page 22.

7.3.3  Removing a Location Profile
1 Right-click the Red N icon on the status bar, then click Novell Client Properties > Location 

Profiles to open the Novell Client property pages.
2 Select the name of the profile that you want to remove, then click Remove > OK.

7.4  Customizing the Novell Login Dialog Box
The Novell Login dialog box can be customized to show the features that you want users to have 
access to. Customizing gives you control over the following:

Initial Novell login

This disables the Novell Login window when the workstation is started. Users must then log in 
using the Red N menu or Start menu.
NMAS authentication
NMASTM authentication adds additional security to the network. However, if your network does 
not use NMAS, login might take additional time and you might want to disable NMAS 
authentication. 
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For more information, see “Disabling NMAS on the Server” in the Novell Modular 
Authentication Services 3.0 Administration Guide (http://www.novell.com/documentation/
nmas30/index.html?page=/documentation/nmas30/admin/data/am4bbpx.html).

IMPORTANT: In the Novell Client Install Manager (nciman.exe), you can control both the 
installation and use of NMAS. On the Installation > Setup page, there is an Install NICI and 
NMAS option. If you option when you create a configuration (unattend) file that is used to 
install multiple clients on your network, NICI and NMAS are not installed. In the Client > 
Advanced Login page, there is an NMAS Authentication option. If you deselect this option, 
Novell Client page does not use NMAS during authentication even if the component is 
installed. If the component is not installed and this option is selected, Novell Client login skips 
the NMAS authentication and installation continues.

OEM extended ASCII password
To enable the use of the OEM extended ASCII characters in passwords, select this option. You 
should use OEM extended ASCII characters only if you have legacy software that requires you 
to use the OEM Code Page. The latest versions of the Novell Client support extended ASCII 
characters using the UNICODE code page and do not need this setting to be enabled in order to 
handle special characters such as Ñ or é.
Default policy support
After the user logs in to the network, the authentication server’s \sys\public\ directory is 
searched for a ntconfig.pol file. If the file is found, the policy is applied to the user and 
workstation.
Novell Login dialog box customization
This dialog box can be customized to control the availability of certain login options. This 
gives you control over how users log in.

Location list at the top of the dialog box
Hiding the Location field is especially useful if you have set up only one location profile 
for a workstation. In this case, the Location field is not useful and might confuse or 
distract users.
Advanced button
If you have set up several location profiles and do not want users to change the data in 
various login fields (such as Tree, Context, Server, and Run Scripts), you can hide the 
Advanced button.
Variables button on the Script tabbed page
If you use %2, %3, %4, or %5 in the login script, you might want to set these values in the 
location profile but not allow users to change them. In this case, it might be helpful to hide 
the Variables button.
Clear Connections check box
If you want all connections to be cleared every time users log in, or if you don't want any 
connections to be cleared, you can set the value in the location profile and then hide the 
Clear Connections check box.

NOTE: The Clear Connections check box is never visible during initial login, because an 
initial login automatically clears all connections.

Workstation Only check box
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If you do not want to allow workstation-only logins—for example, if you want to require 
that users log in to NetWare® in order to use their workstations—you can hide the 
Workstation Only check box that appears under the Password field during an initial login.
Suppress Single Sign on for This Login check box
This check box lets you disable the single sign-on process for the current login attempt.
Tree field
If the Novell Login dialog box is being used to log in to a specific tree, disable the Tree 
field to prevent users from changing the tree.
Tree button
If the Novell Login dialog box is being used to log in to a specific tree, disable the Tree 
button to prevent the user from changing the tree.
Context field
If the Novell Login dialog box is being used to log in to a specific tree, disable the Context 
field to prevent users from changing the context.
Context button
If the Novell Login dialog box is being used to log in to a specific tree, disable the Context 
button to prevent users from changing the context.
Force Logoff button
Force Logoff lets you terminate the previously logged-in user’s Novell Client session even 
if he or she locked the workstation. 

WARNING: Any unsaved work that the previous user had open is lost. To maintain open 
applications and current network connections, log in using the previously logged-in 
username and password. 

Welcome screen
You can customize the Welcome screen with a custom bitmap and caption. 

To show or hide any Login dialog box options:

1 Right-click the Red N icon on the status bar, then click Novell Client Properties to open the 
Novell Client Configuration dialog box.

2 Click Advanced Login.
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Description: Advanced Login Tab

3 Select Show On Login in the Parameter groups drop-down list. 
4 Select the parameter you want, then select On or Off in the Setting drop-down list.

A short description of each parameter is available in the Description field when you select the 
parameter.

5 Click OK.

7.5  Configuring 802.1X Authentication
The Novell Client 4.91 SP5 for Windows XP/2003 includes an Extensible Authentication Protocol 
(EAP) plug-in to the Microsoft Windows XP supplicant, which lets users authenticate through 
RADIUS to wireless access points and wired switches for added network security. Using 
FreeRADIUS (http://wiki.freeradius.org/Main_Page) as the RADIUS server, users can authenticate 
to their local machines, to eDirectory, and to 802.1X with the same set of credentials for a single 
sign-on experience.

When 802.1X authentication is enabled, the username and password entered in the Novell Login 
dialog box are first passed to the EAP plug-in module. An exchange of messages (PEAP/
MSCHAPv2) between the Windows supplicant, the wireless access point/wired switch, and the 
RADIUS server allows network access if the correct credentials were entered. After the 802.1X 
authentication has succeeded, both the eDirectory and local logins take place just as they have in 
previous versions of the Novell Clients. If the 802.1X authentication fails, no access to the network 
is given, and the user will not be able to access the network.
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The 802.1x authentication feature supports both wired and wireless connections. Only password-
based authentication is supported (the Novell Client 4.91 SP5 for Windows XP/2003 supports only 
PEAP with MSCHAPv2). Biometrics (non-password-based) authentication types are not supported 
with this release. If you want certificate support, the Microsoft EAP plug-ins are sufficient and no 
Novell-specific EAP support is required.

The ability to browse for trees and servers in the Novell Login dialog box is not supported because 
the 802.1X port blocks all network access.

TIP: We recommend testing this functionality with user accounts that don't expire. There is a 
possibility that grace login messages won't display to users, which means that users might 
unknowingly exhaust their grace logins.

This configuration is intended for use only with the native 802.1x supplicant provided with 
Windows. We recommend that you install only the driver for your wireless adapter (that is, that you 
do not install other supplicants or utilities that come with wireless adapters). This is because such 
utilities often disable the wireless service in Windows. You should also make sure that the Use 
Windows to configure your wireless network setting is always enabled (to do this, right-click the 
wireless connection).

Section 7.5.1, “Prerequisites,” on page 78
Section 7.5.2, “Enabling 802.1X Authentication,” on page 78
Section 7.5.3, “Troubleshooting Tips,” on page 80
Section 7.5.4, “For More Information,” on page 81

7.5.1  Prerequisites
Install a clean version of Windows XP Service Pack 2 (SP2).
Install the Windows WPA2 wireless patch, available from Update for Windows XP 
(KB893357) (http://www.microsoft.com/downloads/details.aspx?familyid=662bb74d-e7c1-
48d6-95ee-1459234f4483&displaylang=en).
This update to Windows XP provides support for Wi-Fi Protected Access 2 (WPA2), which is 
the latest standards-based wireless security solution derived from the IEEE 802.11i standard.
Install the wlan api patch, available from Wireless LAN API (KB918997) (http://
www.microsoft.com/downloads/details.aspx?FamilyId=52A43BAB-DC4E-413F-AC71-
158EFD1ADA50).
Installing this set of application programming interfaces (APIs) lets you create applications that 
can manage wireless LAN profiles and connectivity on Microsoft Windows XP SP2 using the 
native wireless functionality in Windows, called Wireless Zero Configuration (WZC) service.
Make sure the Authenticate as computer when computer information is available option on the 
Authentication tab of your Local Area Connection Properties dialog box is selected.

7.5.2  Enabling 802.1X Authentication
1 Right-click the Red N in the system tray, then click Novell Client Properties.
2 In the Novell Client Configuration dialog box, click the Location Profiles tab.
3 Select Default in the Location Profiles box, then click Properties.
 Client 4.91 SP5 for Windows XP/2003 Installation and Administration Guide

http://www.microsoft.com/downloads/details.aspx?familyid=662bb74d-e7c1-48d6-95ee-1459234f4483&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=662bb74d-e7c1-48d6-95ee-1459234f4483&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyId=52A43BAB-DC4E-413F-AC71-158EFD1ADA50


novdocx (en)  16 A
pril 2010
4 Select Default in the Service Instance drop-down list, then click Properties.
5 Click the 802.1X tab, then select Enable Tab.

Description: Novell Login dialog box, 802.1X tab

6 Select Login using 802.1X.
You can also select any of the following options:
802.1X Authenticate on subsequent logins: Causes 802.1X authentication to take place when 
a user logs in from the Red N, even if he or she is already logged in to the Windows 
workstation. If the user is not logged in, 802.1X authentication takes place even if this option is 
not selected.
Append Domain name to User name: Prepends the user’s domain to the username when the 
username is submitted to 802.1X. The format is DomainName/username. Use this option if the 
RADIUS server expects the domain name to precede the username. This options is normally 
used when IAS/AD is the RADIUS backend.

NOTE: Contextless login runs after you click OK.

7 Click OK three times.
8 Reboot the workstation for the changes to take effect.

After it is enabled, a 802.1X tab appears in the Novell Login dialog box when you click the 
Advanced tab. Use the options on the tab (see Step 6) to control 802.1X authentication at login 
time.
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Description: Novell Login dialog box, 802.1X tab

IMPORTANT: For 802.1X to work correctly during the initial login, make sure that the 
Authenticate as computer when computer information is available option is selected on the 
Authentication tab of your Local Area Connection Properties dialog box. 

7.5.3  Troubleshooting Tips
If 802.1X authentication succeeds after the desktop is up and you are log in from the Red N but 
fails on the initial boot login, check to see if the Authenticate as computer when computer 
information is available check box on the Authentication tab of your Local Area Connection 
Properties dialog box is selected. This option must be selected for the initial login to succeed.
If the authentication times out, check to see if the radius server is getting queried for the 
authentication. Also check to make sure the Validate server certificate check box on the 
Protected EAP Properties tab on the Local Area Connection Properties dialog box is not 
selected.
If you think debug or trace logs will help, start Regedit and go to 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Tracing and enable tracing for Noveap. This 
causes Windows to create a Noveap.log file in the windows\tracing directory.
Utilities installed with many NIC cards can cause odd behavior. Make sure the user has only 
installed the drivers for the NIC card and none of the other utilities.
If you still cannot get 802.1X to work, remove the Novell Client and try to get the Microsoft 
authentication working first. Pre-desktop authentication will not likely work in this case, but 
after the desktop is up, Microsoft uses the Windows username and password for 802.1X 
authentication.
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For this to work, the username and password for Windows must match the username and 
password in eDirectory. There are many resources on the Web that can help you troubleshoot 
wireless access on Widows XP, including the following:

Troubleshooting IEEE 802.11 Wireless Access with Microsoft Windows (http://
technet.microsoft.com/en-us/library/bb457017.aspx)
How to troubleshoot wireless network connections in Windows XP (http://
support.microsoft.com/kb/313242) 
How to troubleshoot wireless network connections in Windows XP Service Pack 2 (http://
support.microsoft.com/kb/870702)
Troubleshooting Microsoft Windows XP-based Wireless Networks in the Small Office or 
Home Office (http://download.microsoft.com/download/3/4/c/34c120aa-40ed-4683-897c-
e4d157a010d2/WiFi_SOHO_Tshoot.doc) 

After you have wireless authentication working without the Novell Client, install the Client and 
enable the Client’s 802.1X authentication.

7.5.4  For More Information
For more information on 802.1X, see the following:

“802.1x White Paper” (http://www.alliedtelesyn.com/media/pdf/8021x_wp.pdf)
“Configuring 802.1x Authentication” (http://www.cisco.com/univercd/cc/td/doc/product/lan/
cat4000/8_3/configur/8021x.pdf) 
“How to Set Up Secure 802.1x EAP/TLS Access to ATI Switches in a Test Lab” (http://
www.alliedtelesyn.com/media/datasheets/secure_access_testlab_sd_b.pdf)

7.6  Enabling Passive Mode Login
When configured for passive mode login, the Novell Client’s NWGina defers to the Microsoft 
Graphical Identification and Authentication Dynamic Link Library (msgina.dll) for the initial 
workstation login. After authentication to the workstation, NWGina attempts to authenticate to the 
Novell environment. The username and password used for workstation authentication are also used 
for the Novell authentication.

To successfully authentication to the Novell environment, the username must exist in eDirectory, 
and the default location profile must be properly configured with the Tree and Context information.

To enable passive mode login, set the following registry keys:

[HKEY_LOCAL_MACHINE\SOFTWARE\Novell\NWGINA]
“PassiveMode”=dword:00000001

[HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Login]
“PassiveModeNDSLogin”=dword:00000001
“PassiveModeNDSLoginSilent”=dword:00000000 or 00000001
“PassiveModeNDSLoginRequired”=dword:00000000 or 00000001
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Registry Setting Descriptions

PassiveMode: (0/1) default is 0
0 = normal mode
1 = passive mode
PassiveModeNDSLogin: (0/1) default is 0
0 = don't do Novell login
1 = do Novell login 
PassiveModeNDSLoginSilent: (0/1) default is 0
0 = report Novell login errors
1 = don't report Novell login errors
PassiveModeNDSLoginRequired: (0/1) default is 0
0 = don't require Novell login
1 = require Novell login

Notes:

If the PassiveModeNDSLoginRequired setting is True (1), the GINA login experience requires 
a successful Novell authentication in order to succeed. 
The PassiveModeNDSLoginSilent setting requires functionality released in the Novell Client 
for Windows XP/2003 4.91 SP3 or later.
Login scripts are not processed in passive mode. A workaround is to run them after the GINA 
login. You can do this byplacing a run entry in the registry, or you can create an entry in the 
startup folder.
The following in a run key example:
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run]
“nwscript=reg_expand_sz:loginw32.exe %username% /NA /CONT 

7.7  Logging In to the Network
IMPORTANT: We recommend that you do not use any of the legacy NetWare 16-bit DOS utilities 
for managing login, including LOGIN.EXE, LOGOUT.EXE, CX.EXE, ATTACH.EXE, etc. from the 
NetWare server’s SYS:LOGIN or SYS:PUBLIC directories.

There are several ways to initiate a Novell Client login after users have already logged in to a Novell 
server or to the local workstation:

Right-click the Red N icon on the status bar, then click Novell Login. 
Right-click Network Neighborhood, then click Novell Login.
Click Start > Programs > Novell (Common) > Novell Login.
In Network Neighborhood, double-click the desired tree or server and the Novell Login loads 
automatically.
In Network Neighborhood, right-click the desired tree or server and then click either 
Authenticate or Login.
Run loginw32.exe from the command prompt.
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7.8  Logging Out of the Network
To log in to new Novell services while logging out of other servers or clearing the current 
connections, use the Novell Client Login and select the Clear Current Connections option.

If you want to log out of both the Windows workstation and a Novell server, press Ctrl+Alt+Del and 
then click Logout.

To log out of a specific server, right-click Network Neighborhood, click Novell Connections, select 
the server or tree, and then click Detach. Or, right-click the Red N menu, click Novell Connections, 
select the server or tree, and then click Detach.

7.9  Setting Up LDAP Contextless Login and 
LDAP Treeless Login
Several large Novell customers have used LDAP Contextless Login to facilitate the merging of 
several trees in to one global tree. Before LDAP Contextless Login, users were often annoyed by 
being required to change their context information in the login screen when changes took place in 
the tree structure. This resulted in IT costs to manage and support the change. LDAP Contextless 
Login makes it easier for users to work in the new global tree because it makes it unnecessary for the 
users to manage or know about changes to their organization's name or its placement in the 
hierarchy. Because users no longer need to enter their context to authenticate, the context can be 
changed on the back end as many times as necessary without the users needing to know and without 
the costs associated with managing and supporting these changes. 

The Lightweight Directory Access Protocol (LDAP) is an Internet communications protocol that 
lets client applications access directory information. It is based on the X.500 Directory Access 
Protocol (DAP) but is less complex than a traditional client and can be used with any other directory 
service that follows the X.500 standard. Lightweight Directory Access Protocol (LDAP) Services 
for Novell eDirectory is a server application that lets LDAP clients access information stored in 
eDirectory. 

If your network has LDAP Services for Novell eDirectory set up on your eDirectory tree and you are 
running Novell eDirectory 8.5 or later, users who are logging in to the network from Windows can 
log in to the network without having to enter their context in the Novell Login screen. To log in, 
users need to know only their username, password, and the name of the tree that is running LDAP 
Services. Optionally, you can also have users log in to the network without having to specify the 
eDirectory tree name. 

User objects can be located in the tree by username or e-mail address. You can also enable wildcard 
searches. If wildcard searches bring up multiple usernames, the user is prompted to select his 
username. 

Generally, when a user connects to the network using LDAP, the connection is made through an 
LDAP client. Now, the Novell Client Login acts as an LDAP client and connects to the network. All 
LDAP clients bind (connect) to Novell eDirectory as one of the following types of users:

[Public] User (Anonymous Bind) 
Proxy User (Proxy User Anonymous Bind)
NDS® or eDirectory User (NDS User Bind)

NOTE: The NDS User Bind is not used by LDAP Contextless Login. 
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The type of bind and the rights assigned to the corresponding User object determine the content that 
the LDAP client can access. LDAP clients access a directory by building a request and sending it to 
the directory. When an LDAP client sends a request through LDAP Services for eDirectory, 
eDirectory completes the request for only those attributes that the LDAP client has the appropriate 
access rights to. There are additional restrictions that can be set to further secure connections.

This documentation assumes that you are familiar with LDAP. It contains links to information about 
LDAP and eDirectory; it is not meant to replace or supersede the documentation about LDAP 
running on eDirectory. If you are unfamiliar with LDAP, you should familiarize yourself with LDAP 
and how it operates in your network. 

For more information on LDAP for Novell eDirectory, see “Understanding How LDAP Works with 
eDirectory” (http://www.novell.com/documentation/edir88/edir88/data/h0000007.html#h0000007) 
in the Novell eDirectory 8.8 Administration Guide.

Before users can log in to the network without their context or tree information, you must complete 
the following steps:

1 Set up Novell LDAP Services for eDirectory. 
See “Setting Up Novell LDAP Services for eDirectory” on page 84.

2 Do one of the following:
If you are installing Novell Client software on a few workstations, install the software and 
then configure the Novell Client property pages so that the LDAP port number and SSL 
settings in the client properties match the settings on your LDAP server. See “Setting Up 
LDAP Contextless Login on One Workstation” on page 87.
If you are installing Novell Client software on multiple workstations, preconfigure the 
LDAP contextless login property pages prior to installing the client software so that the 
LDAP port number and SSL settings in the client properties match the settings on your 
LDAP server (see “Setting Up LDAP Contextless Login on Multiple Workstations” on 
page 90). Then install the Client software.

3 Inform users about contextless login. 
See “Logging In Using LDAP Contextless Login” on page 90.

If you experience problems with LDAP Contextless Login, check the Server and Group object 
configurations. Most problems occur in the access rights given to the Proxy User. You can use any 
LDAP browser available from the Internet to check the access rights. Browse to the user and verify 
that you can read the inetOrgPerson property and other properties you are searching for, such as CN 
and MAIL. If these cannot be seen through the LDAP browser by logging in anonymously, 
contextless login cannot perform the proper searches to resolve the User object's context in the tree. 

7.9.1  Setting Up Novell LDAP Services for eDirectory
Before users can take advantage of LDAP Contextless Login, the network must be running Novell 
LDAP Services for eDirectory 8.5 or later and you must have completed the following steps: 

1 Install and configure the LDAP Services for eDirectory on the LDAP server. 
See “Understanding LDAP Services for Novell eDirectory” (http://www.novell.com/
documentation/edir88/edir88/data/a4wyf4a.html#a4wyf4a) and “Configuring LDAP Services 
for Novell eDirectory” (http://www.novell.com/documentation/edir88/edir88/data/
ahlmb7h.html#ahlmb7h) in the Novell eDirectory 8.8 Administration Guide.
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2 Do one of the following:
Grant the Read right to the Public Object.
See “Connecting As a [Public] User” on page 85.
Create a Proxy User Object that has the correct rights.
See “Connecting As a Proxy User” on page 85.

Connecting As a [Public] User

An anonymous bind is a connection that does not contain a username or password. If an LDAP 
client without a name and password binds to LDAP Services for eDirectory and the service is not 
configured to use a Proxy User, the user is authenticated to eDirectory as user [Public].

User [Public] is a nonauthenticated eDirectory user. By default, user [Public] is assigned the Browse 
right to the objects in the eDirectory tree. The default Browse right for user [Public] allows users to 
browse eDirectory objects but blocks user access to the majority of object attributes.

The default [Public] rights are typically too limited for most LDAP clients. Although you can 
change the [Public] rights, changing them gives these rights to all users. Because of this, we 
recommend that you use the Proxy User Anonymous Bind. For more information, see “Connecting 
As a Proxy User” on page 85. 

To give user [Public] access to object attributes, you must do the following in iManager or 
ConsoleOne:

1 Make user [Public] a trustee of the appropriate container or containers.
2 Grant the Read right to user [Public]. 

Without the Read right, user [Public] cannot search containers for the User object information. 
You can grant the Read right to the specific attributes that LDAP Contextless Login searches 
for User objects or you can grant rights to all attributes. For example, you can grant rights only 
to the e-mail address or telephone number; when LDAP Contextless Login searches the tree as 
user [Public], it searches only these attributes.

Connecting As a Proxy User

A proxy user anonymous bind is an anonymous connection linked to an eDirectory username. If an 
LDAP client binds to LDAP for eDirectory anonymously, and the protocol is configured to use a 
Proxy User, the user is authenticated to eDirectory as the Proxy User. The name is then configured in 
both LDAP Services for eDirectory and in eDirectory. 

The key concepts of proxy user anonymous binds are as follows:

All LDAP client access through anonymous binds is assigned through the Proxy User object.
The Proxy User must have a null password and must not have any password restrictions (such 
as password change intervals). Do not force the password to expire or allow the Proxy User to 
change passwords.
You can limit the locations that the Proxy User can log in from by setting address restrictions 
for the Proxy User object.
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The Proxy User object must be created in eDirectory and assigned rights to the eDirectory 
objects you want to publish. The default user rights provide Read access to a limited set of 
objects and attributes. Assign the Proxy User Read and Search rights to all objects and 
attributes in each subtree where access is needed.
The Proxy User object must be enabled on the General page of the LDAP Group object that 
configures LDAP Services for eDirectory. Because of this, there is only one Proxy User object 
for all servers in an LDAP group.
You can grant a Proxy User object rights to All Properties (default) or Selected Properties. In 
order for contextless login or treeless login to work, the Read right must be granted so that 
LDAP can search the container or tree for the User object. Typically, you assign the Proxy user 
rights to the Root of the tree so that LDAP can view the attributes of the User objects 
throughout the tree. However, you might want to restrict access by assigning the Read right 
only to individual Organizational Units that you want LDAP to search. 

For more information, see “Configuring LDAP Objects” (http://www.novell.com/documentation/
edir88/edir88/data/agq8auc.html#agq8auc) in the Novell eDirectory 8.8 Administration Guide.

NOTE: LDAP Contextless Login requires clear text passwords to be enabled for LDAP. This does 
not affect the eDirectory password required during Login. They remain encrypted.

To give the Proxy User rights to only selected properties on eDirectory 8.7 or later, complete the 
following steps.

NOTE: LDAP Contextless Login works with eDirectory 8.5 or later. However, these steps apply 
specifically to eDirectory 8.7. If you are using a compatible version other than eDirectory 8.7, check 
the documentation that corresponds to your version for steps. 

In Novell iManager

1 Click the Roles and Tasks button.
2 Click Rights Management > Modify Trustees.
3 Specify the top container the Proxy User is to have rights over or click the Browse button to 

browse to and select the container in question, then click OK.
4 In the Modify Trustees dialog box, click Add Trustee.
5 In the Contents dialog box, browse to and click the Proxy User's object.

In the same dialog box, notice that the Proxy User's object appears in the Selected Objects area 
near the bottom.

6 Click OK.
7 On the Modify Trustees screen, click Assigned Rights for the Proxy User. 
8 Select the All Attributes Rights and Entry Rights options, then click Delete Property.
9 Click Add Property, then select the Show All Properties in Schema options

10 Select an inheritable right for the Proxy User, such as mailstop (in the lowercase section of the 
list) or Title, then click OK.
To add additional inheritable rights, repeat Step 9 and Step 10.

11 Click Done.
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In ConsoleOne

1 Right-click the top container that the Proxy User is to have rights over, then click Trustees of 
This Object > Add Trustee.

2 Browse to the Proxy User, then click OK.
3 Deselect the following:

The Browse right for the Entry Rights property
The Read and Compare rights for the All Attributes Rights property

4 Click Add Property, then select the Show All Properties option.
5 Select an inheritable right for the Proxy User, such as mailstop (in the lowercase section of the 

list) or Title, then click OK.
To add additional inheritable rights, repeat Step 4 and Step 5.

6 Click OK > Apply > Close.

To implement proxy user anonymous binds on eDirectory 8.7 or later, you must create the Proxy 
User object in eDirectory and assign the appropriate rights to that user. Assign the Proxy User Read 
and Browse rights to all objects and attributes in each subtree where access is needed. You also need 
to enable the Proxy User in LDAP Services for eDirectory by specifying the same proxy username. 

In Novell iManager

1 Click the Roles and Tasks button.
2 Click LDAP Management > LDAP Overview.
3 In the LDAP Overview dialog box, click the name of an LDAP Group object to configure.
4 In the Authentication Options area, type the name and context of an eDirectory User object in 

the Proxy User field.
5 Click Apply > OK.

In ConsoleOne

1 Right-click the LDAP Group object.
2 Click Properties > General.
3 Type the name of an eDirectory User object in the Proxy Username field.
4 Click OK.

7.9.2  Setting Up LDAP Contextless Login on One Workstation
After you have set up the LDAP Group object and assigned the correct rights to the User object that 
is associated with the proxy username, you need to set up LDAP Contextless Login on the 
workstations. 

If you want to install on a few workstations, complete these steps. If you want to install on many 
workstations, see “Setting Up LDAP Contextless Login on Multiple Workstations” on page 90.

1 At the user's workstation, right-click the Red N icon on the status bar and then click Novell 
Client Properties.

2 Click the LDAP Contextless Login tab.
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Description: LDAP Contextless Login Tab

3 Do one of the following: 
To enable treeless login, select Enable Treeless Login. Enable Contextless Login is 
automatically selected for you because you must set up contextless login to enable treeless 
login.
To enable only LDAP contextless login, select Enable LDAP Contextless Login. 

4 In the Trees field, specify the name of an eDirectory tree running LDAP services and then click 
Add.

5 In the Servers field, specify the IP address or DNS names of the server running LDAP services 
and then click Add.
Order is important for speed and efficiency because servers are queried for their tree until one 
is found that matches the tree specified by the user.

6 (Conditional) If this is the first time this server has been added to the list, check the server 
properties on the LDAP Server Properties page that appears to make sure that the timeout 
settings and data encryption settings are correct. 
If you are using Secure Socket Layer (SSL) to establish a secure connection, you must specify 
the path and name of the certificate on the workstation. You should also check to make sure that 
the correct port number is specified. 

7 (Conditional) If there are additional servers running LDAP, repeat Step 5 and Step 6 for each 
server.

8 (Optional) Start searching for users in a certain context.
8a Select Enable Context Search Scope.
8b Select the tree, then click Properties.
8c Do one of the following: 

To enable a search in the specified context and any containers in that context, select 
Search Context and Subtree.
To enable a search in the specified context only, select Search Context Only.
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8d Type the distinguished context delimited by commas (standard LDAP format), then click 
Add.
For example: OU=TOKYO,O=DIGITALAIRLINE

TIP: The LDAP property page does not ensure that this context is correct. If users have 
problems logging in, check that you typed this information correctly.

8e (Optional) Add multiple contexts to be searched by repeating Step 8d for each context.
The servers and contexts are searched in order. You can set the order they are searched by 
selecting a server or context and then clicking Up or Down to move its position in the 
search list.

9 Click OK.
10 (Optional) Specify additional eDirectory trees to use by repeating Step 4 through Step 9 for 

each tree.
11 (Optional) Set the optional search and display parameters that LDAP Contextless login uses to 

search the eDirectory tree for users by clicking Settings. 
For example, because users do not need to specify their context, you might want to disable the 
Display Context parameter so that the context is not displayed during login. 

Select the parameter you want, then use the Setting drop-down menu to turn the parameter On 
or Off. A short description of each parameter is available in the Description field when you 
select the parameter.

IMPORTANT: If you set the Cache Previous Search parameter to On, any wildcard searches 
you perform will conflict with this cache. For example, if you search for “mabels” and A.N is 
resolved as the context and then you search for “mabels” in a B.N context, mabels.B.N would 
never be resolved (even with wildcards) because mabels.A.N was resolved and cached first. 
You could clear the cache and allow mabels.B.N to resolve, but then mabels.A.N would not 
resolve.
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The Allow Wildcards in Searches and Cache Previous Search parameters cannot be used 
together. If the Allow Wildcards in Searches parameter is On, the Cache Previous Search 
parameter is not used (even if you turn it on).

12 Click OK to effect the changes and close the property page.

7.9.3  Setting Up LDAP Contextless Login on Multiple 
Workstations
As with all property page settings, you can set these properties for multiple workstations both before 
and after installation. For more information, see Section 5.1, “Setting Properties During 
Installation,” on page 53 and Section 5.3, “Setting Properties on Multiple Workstations after 
Installation,” on page 54.

7.9.4  Logging In Using LDAP Contextless Login
When users log in to the network using LDAP Contextless Login, they must specify the necessary 
information based on the options you specified in the LDAP Contextless Login Settings Protocol 
page, the password, and the name of the tree running LDAP Services for eDirectory. The context 
information is added automatically to the Novell Login window when the username is found.

If you choose to allow wildcard searches, users can perform a wildcard search and the LDAP 
database lists all possible users that meet the wildcard search criteria.
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8Printing to a Network Printer

Printer setup can be automated so that users' workstations attach to the network printers they use 
each time they log in to the network. Users can use the network printers without manually 
connecting to the printer every time they want to print.

After connecting to a network printer, users can select the printer from any application that they are 
using. See the application's documentation for information on using printers.

This section includes the following:

Section 8.1, “Attaching to a Network Printer,” on page 91
Section 8.2, “Setting Up Point and Print,” on page 92
Section 8.3, “Printing DBCS Characters from DOS in Windows,” on page 93
Section 8.4, “Disabling NetWare Login Dialog Boxes Brought Up by the Print Provider,” on 
page 93

8.1  Attaching to a Network Printer
A printer driver for each type of printer must be installed on the workstations.

Users can set up network printing on a workstation by specifying the name of the printer in any of 
the following programs:

Novell® iPrint (http://www.novell.com/documentation/oes2/print-services.html#print-services)
Windows Add Printer Wizard
Novell Capture Printer Port

The following can automate printer connections so that the computer connects to network printers 
each time a user log in:

NetWare® Login Script
Restore Connections
Login Script

8.1.1  Setting Up Network Printing through the Windows Add 
Printer Wizard

1 Click Start > Settings > Printers.
2 Double-click Add Printer and follow the onscreen instructions.
3 When prompted, click Network Printer Server and select a printer you want to use from the 

Shared Printers box.
For NetWare 4 or later networks, double-click Novell Directory Services and find the 
context for the printer. Then select a Printer object from the list.
For NetWare 3 and bindery networks, double-click NetWare Servers. Then double-click 
the name of the server that supports the queues you want to use and select the queue.
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4 (Conditional) If a dialog box prompts you to install a driver for the printer, click OK and install 
it.
4a Select the name of the printer from the Driver box, then click OK.
4b Type the path to the printer driver, then click OK.

5 Run an application and select the network printer when you print.

8.1.2  Specifying Capture Settings with Windows Printing
Windows does not require captured printer ports to print to a network printer. Windows can use print 
devices that are associated with network printers. This allows applications to print directly to a 
network printer.

The CAPTURE utility does not affect Windows printer devices.
Captures are global. If you capture a printer port, the port is available for network printing from 
anywhere in Windows.

Use the Capture Settings dialog box to specify printer settings for print captures created with 
Windows. This can be useful if you want to use a DOS or Windows 3.x application that relies on 
print captures and you can't put the capture in a login script.

To access the Capture Setting dialog box:

1 Right-click the Red N icon on the status bar.
2 Click Novell Capture Printer Port.
3 Type the correct information in the dialog box.
4 Click Settings.

These settings apply only to printer ports that are captured from Windows. Printer ports that are 
captured in a login script or from the command line do not use these settings.

These settings do not apply to printers that appear in the Windows Printers folder.

Changing the printer settings for a specific captured printer port does not change the default printer 
settings.

8.2  Setting Up Point and Print
1 Locate printer driver files from the Windows operating system CD-ROM or the Windows 

printer driver files supplied by the printer's manufacturer.
2 Log in as Admin or as a user with Admin-equivalent rights for the printer or print queue.
3 Select a printer or print queue in the Windows Explorer or Network Neighborhood.
4 Click File > Properties > Setup Point and Print.
5 Specify the path for the printer driver files.

You must be logged in to the tree or server where the path is located. You must also have 
sufficient rights for the specified directory to copy the files there. Users need Read and File 
Scan rights for the specified directory.

6 Click Select Printer Model.
7 Select the manufacturer of the printer.
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8 Select the model of the printer.
9 Click OK.

The printer driver files are copied to the path specified in Step 5.
10 Click OK again.

8.3  Printing DBCS Characters from DOS in 
Windows
In Windows, the default command window runs as a 32-bit process. In order to use the existing DOS 
printer driver for DOS-intrinsic commands, you must use a 16-bit command window.

This allows DOS-intrinsic commands such as COPY and TYPE to use the print driver.

The following instructions explain how to set up Windows to support this. These instructions also 
set up the Windows system to support the printer driver for DOS applications.

1 Edit the autoexec.nt file, found in the %systemroot%\system32 directory, adding the DOS 
printer driver for your specific printer after the following line:
%SYSTEMROOT%\SYSTEM32\VLMSUP.EXE

Make sure that you copy the printer driver to the path you specify in the autoexec.nt file.
2 Save a copy of the Windows\system32\config.nt file with another filename, such as 

config.prt.
3 Edit the new config file, adding the DOSONLY command to the file.
4 Continue the setup process using the instructions for your specific version of Windows.

4a Create a shortcut to the command.com program, found in the Windows\system32 
directory.

4b Right-click the shortcut icon, then click Properties.
4c On the Program property page, click Windows and type the paths for the config and 

autoexec files that you created in Step 1 and Step 2.
4d Double-click the shortcut icon. 

A DOS window opens.

Only DOS applications can be run from this window, but anything that is printed is rendered by the 
printer driver that you installed. Any DOS commands that affect the print driver must be specified in 
this window. DOS applications can be started by any method.

8.4  Disabling NetWare Login Dialog Boxes 
Brought Up by the Print Provider
If users log in to a workstation but do not log in to NetWare and they have NetWare printers 
installed, they are prompted to log in to NetWare once by the QMS print provider and once by the 
NDPS® print provider. These login dialog boxes can be disabled if desired.

Windows has two registry setting options for disabling login dialog boxes:

HKLM\SOFTWARE\Novell\Print\Delay Login\Delay Login=1
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The print provider tells Windows that the printer is a NetWare printer even though the user is 
not authenticated. Then, the provider waits for an action that requires authentication is detected 
before displaying a login dialog box.
HKLM\SOFTWARE\Novell\Print\Never Login\Never Login=1

The print provider never displays the Novell Login dialog box, and print jobs sent prior to 
authentication fail. A message similar to the following is displayed:
Error writing to \\TREE\QUE.context: A write fault occurred on the 
network. Do you wish to retry or cancel the job?
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9Uninstalling the Novell Client

This section explains how to uninstall the Novell® ClientTM for Windows.

Section 9.1, “Uninstalling the Novell Client,” on page 95
Section 9.2, “Uninstalling Network Components Using Update Agent or ACU,” on page 95
Section 9.3, “Uninstalling Network Components During an Upgrade,” on page 96

9.1  Uninstalling the Novell Client
Section 9.1.1, “Windows XP,” on page 95
Section 9.1.2, “Windows 2000,” on page 95

9.1.1  Windows XP
1 Click Start > Control Panel > Add or Remove Programs.
2 Select Novell Client for Windows in the list of currently installed programs, than click Change/

Remove. 
The Novell Client software is removed. However, some files might stay on the workstation 
until it is rebooted.

3 Reboot your workstation. 

9.1.2  Windows 2000
1 Click Start > Settings > Control Panel.
2 Double-click Network Connections.
3 Right-click any network connection (for example, right-click Local Area Connection), then 

click Properties.
4 On the General tab, select Novell Client for Windows, then click Uninstall. 
5 Click Yes when asked if you are sure you want to uninstall Novell Client for Windows.
6 If you are asked if you want to remove the NMAS Client, click Yes.
7 Reboot your workstation. 

9.2  Uninstalling Network Components Using 
Update Agent or ACU 
You can uninstall network components from Novell Client software by using either the Update 
Agent (if it has been configured) or the Automatic Client Upgrade (ACU). This lets you uninstall 
components that are no longer in use in your network. 

1 (Conditional) If you are using the Update Agent to uninstall network components, ensure that it 
has been configured. 
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Update Agent needs to be configured during a software installation or upgrade. You can enable 
Update Agent using ACU or you can enable it locally on each workstation. See “Enabling the 
Novell Client Update Agent by Using ACU Without Installing Novell Client Software” on 
page 41 or see “Enabling the Novell Client Update Agent on a Local Workstation” on page 41. 

2 Modify the acu.ini file so that the components you want to uninstall are set to Yes in the 
[UNINSTALL] section of the .ini file. 
See “Modifying the ACU Configuration File” on page 42 for more information.

3 Run Update Agent or run ACU from the login script.
See “Installing and Upgrading the Novell Client on Multiple Workstations” on page 21.

The components are uninstalled. 

9.3  Uninstalling Network Components During an 
Upgrade
If you are planning to upgrade to the next version of the Novell Client for Windows and you 
currently have one or more optional components installed that you want to have uninstalled, you can 
accomplish both tasks at the same time. For example, if you currently have Novell Distributed Print 
ServicesTM installed on a workstation and you want to uninstall it so that you can later install Novell 
iPrint, you can perform the uninstall of Novell Distributed Print Services while you are installing the 
next version of the Novell Client for Windows.

There are two methods you can use to uninstall components during the upgrade process: 

Modify the ACU configuration file (acu.ini) to uninstall components before the upgrade of 
the Novell Client
Create a configuration (unattend) file in NCIMAN and select components to be uninstalled. 

Using ACU

1 Modify the [Uninstall] section of the acu.ini file and select YES for all components you 
want to uninstall. 
See “Modifying the ACU Configuration File” on page 42.

2 Install the Novell Client using one of the network or Web-based installation methods. 
See Chapter 4, “Installing and Upgrading the Novell Client on Multiple Workstations,” on 
page 21.

Using NCIMAN

1 Create a configuration (unattend) file using nciman.exe. 
See “Creating the Configuration File (Unattend File)” on page 47.

2 From the Installation group, select the components you want to remove. 
3 On the component’s property page, select Remove This Component for each component you 

want uninstalled. 
4 Save the configuration (unattend) file. 
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5 Run Update Agent or run ACU from the login script and specify this configuration (unattend) 
file.
See “Installing and Upgrading the Novell Client on Multiple Workstations” on page 21.

The client software is installed and the unwanted components are removed.
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ATroubleshooting Issues

This appendix provides troubleshooting information for the following known issues related to the 
Novell® ClientTM for Windows:

Section A.1, “Installation,” on page 99
Section A.2, “Login Restrictions Set for IPX/SPX Prevent User from Logging In,” on page 100
Section A.3, “Login Script,” on page 100
Section A.4, “Printing Issues,” on page 102
Section A.5, “Software Compatibility Issues,” on page 102

TIP: If you do not find a solution to your issue here, check the Novell Client Readme or the Novell 
Support Web site (http://support.novell.com).

A.1  Installation
Section A.1.1, “IPX Compatibility Mode and the IPX Internal Network Number,” on page 99
Section A.1.2, “Novell Client Cannot Install If the Local Area Connection Page Is Open,” on 
page 99
Section A.1.3, “Uninstall Novell Client First When Upgrading the Windows Operating 
System,” on page 99
Section A.1.4, “NDPS Update Required on NetWare 5.1,” on page 100
Section A.1.5, “Password Issues,” on page 100

A.1.1  IPX Compatibility Mode and the IPX Internal Network 
Number
Workstations using IPXTM Compatibility Mode cannot have an IPX internal network number 
configured. If you have configured an IPX internal network number on your workstation and you 
plan to install the Novell IP Client with IPX Compatibility Mode, then remove the IPX internal 
network number before installing the client.

A.1.2  Novell Client Cannot Install If the Local Area Connection 
Page Is Open
The Novell Client cannot be installed on Windows XP if the Local Area Connection Properties Page 
is open. Close this page before running the Novell Client install.

A.1.3  Uninstall Novell Client First When Upgrading the 
Windows Operating System
If you are upgrading your Windows operating system on workstations that already have the Novell 
Client installed, you must first uninstall the Novell Client to ensure a clean upgrade.
Troubleshooting Issues 99

http://support.novell.com
http://support.novell.com


100 Novell

novdocx (en)  16 A
pril 2010
On Windows XP, you can install the client software from the network on workstations running the 
Microsoft Client Service for NetWare®. Run the install by logging in to the server using bindery 
emulation.

A.1.4  NDPS Update Required on NetWare 5.1
An update to NDPS® is required to solve a client hang. Install the dprpcnlm.nlm file, dated 22 Nov 
2000 or later. This update is included in NetWare 5.1 Support Pack 3. Refer to TID 10062546 (http:/
/support.novell.com/cgi-bin/search/searchtid.cgi?/10062546.htm).

A.1.5  Password Issues
We recommend that administrators configure Windows workstations to not use any of the Microsoft 
password restrictions available in User Manager. Novell Client for Windows works best if password 
restrictions are left up to eDirectoryTM.

For more information on Novell's Universal Password and advanced password management, see 
Section 6.2, “Managing Passwords,” on page 58.

A.2  Login Restrictions Set for IPX/SPX Prevent 
User from Logging In
Login restrictions are set for IPX/SPXTM and the node address. When the administrative workstation 
is reset, the new client files are automatically updated and the reboot prompt is displayed. After 
restarting, the workstations that are placed in the restriction list as being able to log in as admin and 
that now have the new client cannot log in and no administration of the server can be done.

This is a problem with preferring the IP protocol. The allowed addresses assigned in eDirectory are 
IPX addresses. If the server is bound to IP, the clients are designed to prefer this protocol by default. 
The result is that the client is attempting to log in to the server using IP but the address is restricted 
to allow only IPX addresses, causing an authentication failure. This is because the IP address is not 
stored in eDirectory.

To avoid the problem, do not bind IP to the server until static IP addresses have been assigned. Or, 
change your protocol preference to IPX.

A.3  Login Script
Section A.3.1, “CAPTURE Execution in a Login Script,” on page 100
Section A.3.2, “Login Script Command SET_TIME ON/OFF Error if a User Does Not Have 
Administrator Rights,” on page 101
Section A.3.3, “Map.exe Utility,” on page 101
Section A.3.4, “Drive Mappings Automatically Root Mapped,” on page 101

A.3.1  CAPTURE Execution in a Login Script
If you use a login script that contains an external CAPTURE command using capture.exe, the screen 
might go blank with a blinking cursor in the upper left corner. The capture eventually executes and 
the screen returns to normal.
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This happens if Windows is set to “full screen” when the CAPTURE command is executed from the 
login script. Although the system might be working correctly, a slow server performing the capture 
with a blank screen might make it appear otherwise.

To correct this problem:

1 Double-click My Computer, then click Control Panel > MS-DOS Console.
2 In the Console Windows Properties dialog box, click the Options tab.
3 From the Display Options group, click Window.

A.3.2  Login Script Command SET_TIME ON/OFF Error if a User 
Does Not Have Administrator Rights
Novell Client for Windows Properties > Advanced Settings contains a Set Station Time property. 
When this setting is On, and the logged-in user has administrator rights, the workstation time is 
synchronized with the network during GINA Login. The login script SET_TIME command has no 
effect on time synchronization, because the time is being synchronized before the script command is 
processed. When the setting is Off, the SET_TIME ON script command has an effect when scripts are 
run, and the workstation time is synchronized with the network.

If the logged-in user does not have administrator rights on the workstation, an error is displayed 
when the login script runs and the time is not synchronized. 

A.3.3  Map.exe Utility
The map.exe utility might function improperly if the computer's DOS environment size is too small. 
If you encounter problems while running map.exe, increase the DOS environment size by adding or 
editing the SHELL= line in the Windows\system32\config.nt file. For example:

SHELL=%SYSTEMROOT%\SYSTEM32\COMMAND.COM /E:2048

Map.exe was not designed as a Windows executable and, therefore, does not recognize drives 
mapped to NT servers as network drives. Consequently, the MAP command does not list NT 
network drives. The Windows NT NET USE command can be used to correctly connect and list 
network drives for both NetWare and NT servers.

A.3.4  Drive Mappings Automatically Root Mapped
In Windows, all drive mappings made using the NetWare Login are root mapped. Because of this, 
programs cannot access directories above the directory that the drive is mapped to. This feature 
affects only MAP commands performed in a login script. After Windows has been started, Windows 
allows you to map only to the root.

You can turn off the default by adding SET MAPROOTOFF=“1” as the first line in the login script. 
This globally forces all workstations using the login script to not map root drives.

Or, you can perform the following procedure on a local workstation:

1 Right-click My Computer.
2 Click Properties > Advanced > Environment.
3 Click New to create a new variable.
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4 Type MAPROOTOFF as a variable.
5 Set the value of the MAPROOTOFF variable to 1.
6 Click OK > OK.

A.4  Printing Issues
You might experience difficulties printing through NDPS if your network connection is dropped and 
later auto-reconnects. You could receive the following error messages:

Error writing to <printer>: Space to store the file waiting to be printed is 
not available on the server.

A write fault occurred while printing.

To resolve this problem, you must download and install NetWare 5 Support Pack 2 or later. Then 
complete the following:

1 At the server console, load ndpsm.nlm to load NDPS Manager on the server.
2 From the NDPS Manager main menu, select Printer Agent List.
3 Select a Printer Agent.
4 After the Printer Agent information is displayed, click Configuration: (See Form).
5 From the configuration screen, change the Security Level from High to Medium.

A.5  Software Compatibility Issues
Novell Client for Windows coexists with the Microsoft SMB Client. The Microsoft SMB Client 
utilizes NetBIOS, which increases the utilization of your network.

If you want to prevent the Microsoft SMB Client from communicating over NetBIOS, modify your 
workstation configuration by unbinding the workstation and server from NetBIOS on the Network 
Properties page.
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BDocumentation Updates

The Novell® ClientTM for Windows Administration Guide has been updated with the following 
information on the following dates:

Section B.1, “October 19, 2010,” on page 103
Section B.2, “April 29, 2009,” on page 103
Section B.3, “October 14 2008,” on page 103
Section B.4, “September 2008 (SP5),” on page 104
Section B.5, “June 2, 2008 (SP4),” on page 104
Section B.6, “July 17, 2007 (SP4),” on page 104
Section B.7, “October 25, 2006 (SP3),” on page 104
Section B.8, “December 23, 2005 (SP2),” on page 104
Section B.9, “August 19, 2005 (SP1),” on page 105

B.1  October 19, 2010

B.2  April 29, 2009

B.3  October 14 2008

Location Change

Section 7.5.3, “Troubleshooting Tips,” on page 80 Updated the first link regarding wireless access.

Location Change

Various Updated outdated references to SP4 to indicate 
SP5.

Location Change

Section 7.7, “Logging In to the Network,” on 
page 82

Clarified that the legacy NetWare 16-bit DOS 
utilities are not recommended for managing login.
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B.4  September 2008 (SP5)

B.5  June 2, 2008 (SP4)

B.6  July 17, 2007 (SP4)

B.7  October 25, 2006 (SP3)

B.8  December 23, 2005 (SP2)

Location Change

Title Page The title page design is updated in the PDF 
version of this guide.

Location Change

“Configuring Challenge/Response Settings” on 
page 63

Added information about hiding responses to 
challenge questions.

Location Change

Section 7.5, “Configuring 802.1X Authentication,” 
on page 77

This section was added.

Location Change

Section 9.1, “Uninstalling the Novell Client,” on 
page 95

Updated the section with separate instructions for 
Windows XP and Windows 2000.

Section 4.3.4, “Distributing setupip.exe,” on 
page 36

Added information on how setupip.exe 
determines what language version of the Novell 
Client to install.

Location Change

Entire guide Page design reformatted to comply 
with revised Novell documentation standards.

Section 6.2.2, “Displaying Password 
Requirements for End Users,” on page 60

Updated section to reflect changes made in the 
Novell Client for Windows 4.91 SP2.

Section 6.3, “Using Forgotten Password Self-
Service,” on page 61

Updated section to reflect changes made in the 
Novell Client for Windows 4.91 SP2.
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Location Change

Section 6.2, “Managing Passwords,” on page 58 Reorganized the section.

Section 6.3.1, “Using the “Did You Forget Your 
Password?” Link,” on page 62

This section was added.
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